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Preface

This preface describes the audience and conventions of the Cisco Unity Maintenance Guide, and 
provides information on how to obtain related documentation.

Audience
The Cisco Unity Maintenance Guide is written for technicians and information systems professionals 
who are responsible for maintaining Cisco Unity software and hardware.

Document Conventions
Table 1 Cisco Unity Maintenance Guide Conventions 

Convention Description

boldfaced text Boldfaced text is used for:

 • Key and button names. (Example: Click OK.)

 • Information that you enter. (Example: Enter Administrator in the User 
Name box.)

< > 

(angle brackets)

Angle brackets are used around parameters for which you supply a value. 
(Example: In the Command Prompt window, enter ping <IP address>.)

- 

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press 
Ctrl-Alt-Delete.)

> 

(right angle  
bracket)

A right angle bracket is used to separate selections that you make:

 • On menus. (Example: On the Windows Start menu, click 
Settings > Control Panel > Phone and Modem Options.)

 • In the navigation bar of the Cisco Unity Administrator. (Example: Go to the 
System > Configuration > Settings page.)
i
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Cisco Unity Documentation
The Cisco Unity Maintenance Guide also uses the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

Cisco Unity Documentation
For descriptions and URLs of Cisco Unity documentation on Cisco.com, refer to About Cisco Unity 
Documentation. The document is shipped with Cisco Unity and is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

 • Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

 • Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 1 800 553-NETS (6387).
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Documentation Feedback
Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems 
Attn: Customer Document Ordering 
170 West Tasman Drive 
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco 
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical 
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical 
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service 
contract, contact your reseller.

Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 
365 days a year, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. 
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support 
Website by clicking the Tools & Resources link under Documentation & Tools. Choose Cisco Product 
Identification Tool from the Alphabetical Index drop-down list, or click the Cisco Product 
Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by product ID 
or model name; by tree view; or for certain products, by copying and pasting show command output. 
Search results show an illustration of your product with the serial number label location highlighted. 
Locate the serial number label on your product and record the information before placing a service call.
iii
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Obtaining Additional Publications and Information
Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

 • Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit 
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

 • The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/
iv
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Obtaining Additional Publications and Information
 • Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

 • Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

 • iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

 • Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

 • World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
v
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C H A P T E R 1

Introduction

Overview: Maintaining Cisco Unity
All of the software and hardware associated with the Cisco Unity server requires maintenance to ensure 
availability. Degradation in any piece of the installed software can affect server performance. If you do 
regular maintenance, you can reduce the likelihood of unplanned downtime.

See the following sections in this chapter for more information:

 • Scheduling Maintenance Tasks, page 1-1—This section provides an overview of system 
maintenance tasks and suggested frequency.

 • Setting Up a Test Environment, page 1-3—This section describes the recommended test and 
production environments.

Scheduling Maintenance Tasks
The frequency of scheduled maintenance depends on your particular environment, taking into account 
such issues as system size, configuration, and traffic levels. At a minimum, we recommend that you do 
scheduled maintenance as shown in Table 1-1. If you already do the following tasks more frequently than 
we recommend, use your schedule rather than our recommendations.

Table 1-1 Maintenance Tasks and How Often to Do Them 

Task Daily Monthly Other

Forward unaddressed messages to the appropriate 
recipients. For more information, see the “Forwarding 
Unaddressed Messages to the Correct Recipients” 
section on page 4-1.

  Continually

Scan for viruses. See the “Scanning for Viruses” section 
on page 4-2.

X   

Back up the Cisco Unity server. See the “About Backing 
Up a Cisco Unity System” chapter.

X   

Verify that messages in the Unity Messaging Repository 
(UMR) are being delivered.

X   

Determine whether failover has occurred. X   
1-1
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Chapter 1      Introduction
Scheduling Maintenance Tasks
Check to see whether Cisco Unity Administrator 
sessions are not in use and are not being freed by 
Cisco Unity.

X   

Verify that the system backup is complete before the 
beginning of the next business day.

 X  

Verify that the backup medium has enough room to back 
up the entire contents of the Cisco Unity server.

 X  

Install the latest Cisco Unity-qualified service packs 
and security hot fixes. See the “Recommended Service 
Packs and Updates Overview” section on page 7-1.

 X  

Run the Cisco Unity Directory Walker (DbWalker) 
utility to check database integrity. Fix any errors 
encountered by following the on-screen instructions. 
See the “Running the DbWalker Utility” section on 
page 4-3.

 X  

Update the system clock. See the “Updating the System 
Clock” section on page 4-4.

 X  

Check for disk fragmentation on the Cisco Unity server. 
If the total fragmentation appears to be more than 10 
percent or if Cisco Unity files have become overly 
fragmented (more than 500 fragments), defragment the 
volume.

  Offline defragmentation every six months

Update virus-scanning definitions. See the “Updating 
Virus-Scanning Definitions” section on page 4-3.

  When new definitions become available

Restart the Cisco Unity server. See the “Restarting the 
Cisco Unity Server” section on page 4-5.

  According to your current schedule, or as 
needed

Run and review Cisco Unity reports. See the 
“Generating Reports” section on page 9-2.

  As needed

Monitor system resources. See the “Performance 
Monitoring” chapter.

  According to your current schedule, or as 
needed

Monitor the available disk space and rate of database 
growth.

Caution Filling a disk beyond 80 percent capacity will 
result in significant performance 
degradation. A disk filled beyond 80 percent 
capacity requires an increased number of 
data reads and writes to complete file 
transactions, adversely affecting Cisco Unity 
response time. If the disk fills up completely, 
the database cannot grow, and Cisco Unity 
will stop functioning.

  According to your current schedule, or as 
needed

Monitor the available forums for Cisco Unity.   As needed

Table 1-1 Maintenance Tasks and How Often to Do Them (continued)

Task Daily Monthly Other
1-2
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Setting Up a Test Environment
If your Cisco Unity system is set up for failover, you may need to do maintenance tasks specific to 
failover. For details, refer to the “Monitoring and Maintaining Cisco Unity Failover” chapter in the 
Cisco Unity Failover Configuration and Administration Guide. (The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/dom/index.htm.)

Setting Up a Test Environment
If your system resources allow it, we recommend establishing a test environment for the entire 
Cisco Unitydeployment. The test environment can be smaller in scale than the production environment, 
but should have the same configuration characteristics.

Use the test environment to validate any proposed changes prior to implementing them on the production 
system. This includes any upgrades or patches to Cisco Unity, the phone system, and the network, 
including but not limited to the automated attendant, ports, schedules, call handlers, class of service, 
distribution lists, languages, the mail store, and third-party software.

Document the initial configurations of both the production and the test environment, and keep a log of 
all changes made. Failing to do so can affect the supportability of Cisco Unity in the production 
environment, causing unnecessary delays if support personnel must work around undocumented 
changes. Also, failing to document the current environment and any changes made to the test and 
production systems can affect the ability to efficiently and successfully expand the system and to do 
major upgrades in the future.
1-3
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C H A P T E R 2

Configuring Cisco Unity for Maintenance Tasks

Status Monitor
The Status Monitor is a Web-based application on the Cisco Unity server that runs separately from the 
Cisco Unity Administrator. It contains pages that provide information about system status, ports, 
reports, and disk drives. Each page of the Status Monitor displays key status information from the other 
Status Monitor pages in the taskbar at the bottom of the screen. (See Table 2-1 for information about 
each page in the Status Monitor.)

To access the Status Monitor, use one of the following two procedures. The method you use to log on to 
the Status Monitor depends on the authentication method that it uses. To learn more about the 
authentication methods that you can use with the Cisco Unity Administrator and the Status Monitor, 
refer to the “Determining Which Authentication Method to Use for the Cisco Unity Administrator and 
Status Monitor” section in the “Authentication for Cisco Unity Applications” chapter in the Cisco Unity 
Security Guide. For more information on the accounts that you can use to access Cisco Unity, refer to 
the “About the Accounts That Can Be Used to Administer Cisco Unity” section in the “Accounts and 
Permissions” chapter of the same guide. The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/usg/dom/index.htm.

To Log On to the Status Monitor When It Uses Integrated Windows Authentication

Step 1 Log on to Windows on the Cisco Unity server (or a remote computer) by using either the administration 
account or an applicable Windows domain account.

Step 2 If you logged on to the Status Monitor on the Cisco Unity server, double-click the desktop shortcut to 
the Status Monitor.

If you logged on to the Status Monitor on a computer other than the Cisco Unity server, start Internet 
Explorer, and go to http://<Cisco Unity server name>/status.

Step 3 If Internet Explorer prompts you for a user name and password, enter the user name, password, and 
domain for the administration account or for an applicable Windows domain account.

To Log On to the Status Monitor When It Uses Anonymous Authentication

Step 1 Log on to Windows on the Cisco Unity server (or a remote computer) by using any domain account that 
has the right to log on locally.

Step 2 If you logged on to the Status Monitor on the Cisco Unity server, double-click the desktop shortcut to 
the Status Monitor.
2-1
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Status Monitor
If you logged on to the Status Monitor on a computer other than the Cisco Unity server, start Internet 
Explorer, and go to http://<Cisco Unity server name>/status.

Step 3 On the Cisco Unity Log On Page, do one of the following sub-steps:

 • Enter the full name and Internet password of a Domino account that is associated with an applicable 
Cisco Unity subscriber account, and click Log On.

 • Click Log On Using Windows Authentication.

Step 4 On the Cisco Unity Log On page, enter either the user name, password, and domain for the 
administration account, or enter the user name, password, and domain for an applicable Windows 
domain account, and click Log On.

Table 2-1 describes each page in the Status Monitor.

Access to the Status Monitor is controlled by class of service. Internet Explorer is also required to view 
the Status Monitor pages.

To Set Up or Modify Access to the Status Monitor

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Class of Service page.

Step 2 Click the Find icon.

Step 3 Double-click the class of service that you want to modify.

Step 4 Go to the System Access page.

Step 5 Check the Unity Administrator Application Access check box.

Step 6 Under Troubleshooting and Administration, check the Status Monitor Access check box.

Table 2-1 Status Monitor Pages 

Button Page Name Description

System Status Shows whether Cisco Unity is operating, and allows you to start and exit from Cisco Unity. You 
can choose to exit after all calls are finished or to interrupt calls in progress with a message and 
then disconnect all calls and exit.

Port Status Shows the status of each port. This page is useful for testing and troubleshooting. For example, 
you can monitor an incoming call to see which call handlers the call is routed to.

Report Status Shows the status of reports that have been generated.

Disk Drive 
Status

Shows the total size and the available space of each drive and partition on the Cisco Unity 
server.

Help Displays Help.
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Step 7 Click the Save icon.

Event Monitoring Service
The Event Monitoring Service (EMS) utility sends e-mail, voice messages, or both to subscribers or 
public distribution lists in response to an error condition or potential problem on the Cisco Unity server. 
The EMS can also send SNMP alerts and syslog notifications for Simple Network Management Protocol 
(SNMP) configurations. The utility monitors the Windows application log and sends a notification when 
a specified event occurs, such as “Disk almost full.”

The EMS has one predefined event notification, All Unity Errors, that sends notification for all errors 
that originate from a Cisco Unity component. This predefined event notification is disabled by default 
and cannot be deleted. However, you can modify the All Unity Errors event by excluding individual 
sources.

By using the EMS, you can do the following:

 • Create new event notifications

 • Modify existing event notifications

 • Add recipients

 • Delete recipients

 • Enable and disable event notifications

 • Individually enable and disable the receipt of event notifications for specific recipients

 • Configure how frequently recipients are notified for a particular event

 • Choose the message type with which EMS notifies recipients (for details, see Table 2-2)

Table 2-2 Types of Message Notifications That EMS Can Send 

Message Type Description

Voice message A recorded notification is sent to one or more subscribers or public distribution 
lists. With this option, you can use the default message, or you can record the 
message you want to be sent. The recording must be a WAV file. If Cisco Unity is 
configured for failover, the WAV file must also be saved on the secondary server. 
You can use a recording and playback device on the active primary server to record 
your message.

E-mail message A text message is sent to one or more subscribers or public distribution lists.

SMTP message A text message is sent by using the SMTP server included with IIS. This capability 
is useful when you want to send notification through the Internet to an e-mail 
address at another location. Because this method does not depend on Cisco Unity 
for the notification, it can be used to monitor events that indicate catastrophic 
failure of Cisco Unity.

SNMP trap SNMP trap notification works with the Remote Serviceability Kit (RSK) to allow 
you to configure SNMP notifications for monitored Windows Event log entries. You 
configure the SNMP destinations via the SNMP Service properties in the Services 
configuration manager in Windows. For information on setting up SNMP on the 
Cisco Unity server, see the “Setting Up SNMP Notification” section on page 2-4.
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The EMS monitors the Windows Event logs; it does not write events to the system or security logs. For 
information on how to generate an Event log report for all application events on the Cisco Unity server, 
or for the events that apply only to Cisco Unity, see the “Event Log Report” section on page 9-10. You 
can also view application events by using the Windows Event Viewer (on the Windows Start menu, click 
Programs > Administrative Tools > Event Viewer). You can identify the Cisco Unity events as those 
events that begin with CiscoUnity (for example, “CiscoUnity_LogMgr”). For more information on 
Windows events, refer to the Windows Event Viewer Help.

Setting Up SNMP Notification
Do the following procedures if you want to use SNMP notification with the EMS. Refer to the Microsoft 
Windows Help for additional SNMP configuration information.

To Set Up the Remote Serviceability Kit

Step 1 On the Cisco Unity server, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Diagnostic Tools, double-click Remote Serviceability Kit Configuration 
Wizard.

Step 3 Follow the on-screen instructions.

Step 4 Continue with the following “To Set Up SNMP Security” procedure.

To Set Up SNMP Security

The Windows 2000 SNMP agent provides security through the use of community names and 
authentication traps. 

Step 1 On the Cisco Unity server, on the Windows Start menu, click Settings > Control Panel > 
Administrative Tools > Services.

Step 2 Right-click the SNMP Service.

Step 3 Click Properties.

Step 4 Click the Security tab.

Step 5 In the Accepted Community Names field, click Add.

Step 6 In the Community Name field, enter the name of the community.

Step 7 In the Community Rights field, choose either Read-Only or Read-Write. (If you want to be able to 
change the Cisco Unity configuration parameters, choose Read-Write.)

Syslog A Windows Event log entry is sent through the IP network to a syslog server.

Failover Failover notification initiates a failover on any event for which this recipient is 
enabled. Use this type of notification with extreme caution. Create a unique 
recipient for failover notification and use this recipient only for very specific 
Cisco Unity error events.

Table 2-2 Types of Message Notifications That EMS Can Send (continued)

Message Type Description
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Step 8 Click Add.

Step 9 Choose the Accept SNMP Packets from These Hosts option if you want to allow only specific Network 
Management System (NMS) hosts to query the SNMP extension agent.

Step 10 Click Add.

Step 11 Enter the IP address for the hosts that are allowed to query the SNMP extension agent.

Step 12 Click Add.

Step 13 Check the Send Authentication Trap check box if you want to receive SNMP authentication failure 
traps.

Step 14 Continue with the following “To Set Up the SNMP Trap Receiver” procedure. Do not exit from the 
SNMP Properties page.

To Set Up the SNMP Trap Receiver

Step 1 Click the Traps tab.

Step 2 In the Community name field, enter the community name to be used in the trap messages that are 
generated from this host.

Step 3 Click Add to List.

Step 4 In the Trap Destinations field, click Add.

Step 5 In the Trap Destinations field, enter the IP address or hostname of the trap destination.

Step 6 Click Add.

Step 7 Repeat Step 4 through Step 6 for each trap destination that is required.

Step 8 Click OK.

Step 9 Continue with the following “To Start the Cisco Unity SNMP Extension Agent” procedure. Do not exit 
from the SNMP Properties page.

To Start the Cisco Unity SNMP Extension Agent

The SNMP service should start automatically when the Cisco Unity server is started or restarted. Do this 
procedure to confirm that the service is configured properly and to start it if it is not currently running.

Step 1 Click the General tab.

Step 2 Confirm that the Startup Type is Automatic. If the Startup Type is set to any other value, change it to 
Automatic.

Step 3 Confirm that the Service Status is Started. If the status is set to any other value, click Start.

Step 4 Click OK.
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Do the following procedure to set up event notification. For instructions on modifying events, message 
types, or recipients, refer to the EMS Help.

To Set Up Event Notification

Step 1 On the Cisco Unity server, click the Cisco Unity Tools Depot icon.

Step 2 In the left pane of the Tools Depot window, expand Diagnostic Tools, and double-click Event 
Monitoring Service.

Step 3 If you are starting the Event Monitoring Service for the first time, when prompted, enter the password 
for the account that the AvCsMgr service logs on as, and click OK. Otherwise, continue with Step 4.

Step 4 On the File menu, click New > Recipient. The Create New Recipient dialog box appears.

Step 5 In the Recipient Name field, enter a name for the recipient.

Step 6 To select the methods of notification for this recipient, complete the information on one or more of the 
tabs as applicable:

 • Click the Voice Mail tab. Select either a Subscriber or a Distribution List.

 • Click the E-Mail tab. Select either a Subscriber or a Distribution List.

 • Click the SMTP tab. Enter a fully qualified SMTP address that you want to receive notification. 
Click >> to add one or more SMTP addresses to the SMTP Addresses list.

 • Click the SNMP Trap tab. Check the SNMP Trap Enabled check box.

 • Click the Syslog tab. Check the Enabled check box. In the Server field, enter the IP address of the 
syslog server that you want to receive the Event log message.

 • Click the Failover tab. We recommend that you create a unique recipient that is used only for 
initiation of failover.

Step 7 Click OK.

Step 8 In the File menu, click New > Event. The Add New Event dialog box appears.

Step 9 In the Source list, click the name of the source for the error you want to monitor. Or, you can import an 
event that you have copied from the Windows Event log to the clipboard.

Step 10 Under ID, click one of the following:

Step 11 In the Type list, click one of the following:

All Event IDs Sends notification for all Event log messages from the source you selected in 
Step 9.

Specific Event ID Sends notification only for the Event ID you enter in the field to the right of this 
option.

Errors Sends notification only for error events that appear in the Event log.

Errors & Warnings Sends notification for error and warning events that appear in the Event log.

Errors, Warnings & 
Informational

Sends notification for error, warning, and informational events that appear in 
the Event log.
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Step 12 Check the Active check box.

Step 13 In the Notes field, enter text to indicate what this event monitors.

Step 14 To configure a voice message for use with message notifications, continue with Step 15.

To configure e-mail or SMTP content for use with message notifications, continue with Step 16.

Step 15 Select a voice message for use with voice message notifications by doing the following sub-steps:

a. To the right of the Voice Mail File Name field, click ..., browse to the WAV file you want to use as 
the voice message, and click OK. EMS will send this recording as a voice message.

b. In the Voice Mail Priority list, click Urgent, Normal, or Low, as applicable.

c. Continue with Step 17.

Step 16 Configure e-mail or SMTP content for use with e-mail or SMTP notifications by doing the following 
sub-steps:

a. In the E-Mail Subject field, enter the subject line for the e-mail or SMTP notification that EMS will 
send. You can enter text, or right-click to see a menu of insertion strings that EMS provides. For 
example, you can enter Cisco Unity Failover Occurred.

b. In the E-Mail Priority field, click Urgent, Normal, or Low, as applicable.

c. In the E-Mail Body field, accept the default body text, or enter customized text for the e-mail or 
SMTP notification that EMS will send. You can enter text, or right-click to see a menu of insertion 
strings that EMS provides.

d. Click OK.

e. Continue with Step 17.

Step 17 In the right pane of the Event Monitoring Service window, under Recipients, click the Add Recipients 
icon.

Step 18 In the Edit Recipients for Event dialog box, check the Active check box for the recipients you want to 
receive the event notification, and click OK.

Step 19 Near the top of the right pane, click Apply.

Step 20 Close the Event Monitoring Service window and the Tools Depot window.

Best Practices for Managing Subscriber Mail File Size
You can manage subscriber mail file size in the following ways:

Understand How Cisco Unity Handles Full Mail Files and How Performance Is Affected by Mail File Size

To learn more about how Cisco Unity handles subscribers with full mail files, refer to the “How 
Cisco Unity Handles Full Mailboxes” section in the “Default Accounts and Message Handling” chapter 
of the Cisco Unity System Administration Guide. (The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.htm.)

Because the processing of messages happens in real-time when the users log on to check their messages, 
mail file size directly affects Cisco Unity conversation performance. For mail file size recommendations 
and other performance considerations, see the “Administrative Monitoring Guidelines for Cisco Unity 
Performance” section on page 6-8.
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Understand That Codec Choice Affects Message File Size

As illustrated in Table 2-3, the codec used to record a voice message has an effect on the file size of the 
message. Messages recorded with the G.711 Mu-Law and A-Law codec require the most disk space to 
store, while the G.729a codec offers the smallest file size.

Stored voice messages can consume considerable amounts of disk space. The amount of storage a WAV 
file uses depends on what kind of compression the codec uses, if any. The higher the compression, the 
smaller the file and the affect on the disk-space of the database and at the subscriber workstation. 
However, some sound-quality reduction and some CPU processing overhead may result when 
compressing messages during recording and decompressing at playback.

Note Audio quality ratings are subjective, and are provided here only for basic comparison between the 
different fully supported codecs.

For information on choosing and implementing audio codecs, refer to the White Paper: Audio Codecs 
and Cisco Unity, available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/whitpapr/codecs.htm.

Prevent Mailboxes From Filling Up While Subscribers Are on Vacation or on an Extended Leave of Absence

For as long as a subscriber alternate greeting is enabled, you can specify that Cisco Unity will prevent 
callers from leaving messages for the subscriber, which can help reduce mailbox size when subscribers 
are out of the office and do not plan to check messages regularly. In addition, you can increase caller 
awareness of a subscriber absence by specifying that Cisco Unity will prevent callers from skipping the 
greeting.

To set caller options for a subscriber alternate greeting, refer to the “Subscriber Greetings Settings” 
section in the “Subscriber Settings” chapter in the Cisco Unity System Administration Guide. (The guide 
is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.htm.)

Train Subscribers to Better Manage Their Own Mailbox Size

Unified messaging subscribers can make room in their mailboxes by deleting messages (including 
messages in the Sent and Trash folders in Lotus Notes, if applicable) or by saving them to their hard 
drives.

For these and more tips, refer subscribers to the “The Tools You Use” chapter of the Cisco Unity User 
Guide. (The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/ug/ug405/dom/index.htm.)

Table 2-3 Voice Message File Sizes and Audio Quality Ratings 

Audio Codec
Approximate File Size,  
1-Minute Message Quality Rating

G.711 Mu-Law and A-Law 480 KB Excellent

G.726 32 Kbps 240 KB Fine

OKI ADPCM 8 kHz 240 KB Fine

OKI ADPCM 6 kHz 180 KB Fine

GSM 6.10 98 KB Good

G.729a 60 KB Good
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About Backing Up a Cisco Unity System

Introduction
This chapter describes in general terms backing up a Cisco Unity system.

When you back up a Cisco Unity server (and one or more Domino servers) you need to consider the same 
issues involved in backing up any other system. (Note that the service packs, Engineering Specials, and 
Service Releases that are installed on the Cisco Unity server are not significant to the backup process.)

Caution To back up SQL Server/MSDE data, you need to use the SQL Server agent for your backup software, 
which allows you to back up open SQL Server/MSDE database files. If you are backing up Domino data 
as part of the Cisco Unity backup, you also need to use the Domino agent for your backup software, 
which allows you to back up open Domino database files.

Refer to the following for a list of backup software that is qualified for use with Cisco Unity, and for the 
Cisco Unity backup software support policy:

 • For the Cisco Unity server—The “Supported Backup Software” section of the Cisco Unity System 
Requirements, and Supported Hardware and Software, available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/sysreq/40_sysrq.htm.

 • For the Cisco Unity Bridge server—The “Supported Backup Software” section of the Cisco Unity 
Bridge System Requirements, and Supported Hardware and Software at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/bridge30/sysreq/30bsysrq.htm.

See the following sections for information about backing up your Cisco Unity system:

 • Data That May Be Lost Even If Backups Are Done Properly, page 3-2

 • Considerations for Choosing Backup Software, page 3-3

 • Preparations for Backing Up a Cisco Unity System, page 3-3

 • Backups of the Cisco Unity System, page 3-6

 • Backing Up a Cisco Unity Bridge Server, page 3-9

 • Considerations for Testing Backups, page 3-9
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Data That May Be Lost Even If Backups Are Done Properly
If a hard disk in the Cisco Unity server fails, or if the server itself fails or is lost in a disaster, you may 
still lose some data even with a well-designed and well-executed backup plan. This section describes the 
data that may be lost if a hard disk fails, or if a server fails or is lost. Note that no mention is made of 
Domino directory data or messages because installing Domino on the Cisco Unity server is not 
supported. See the following sections:

 • Risks of Lost Data If a Hard Disk in a RAID Fails, page 3-2

 • Risks of Lost Data If a Non-RAID Hard Disk Fails, page 3-2

 • Risks of Lost Data If a Server Is Stolen or Destroyed, page 3-2

Risks of Lost Data If a Hard Disk in a RAID Fails
No data will be lost if only one disk in the RAID fails, as long as a supported fault-tolerant RAID 
configuration is implemented. (Cisco Unity does not support non-fault tolerant RAID configurations, in 
which data could be lost if a single disk failed.) However, the following limitations will exist:

 • If the failure occurs in a RAID 1 array composed of only two disks, there will be no fault tolerance 
until the failed disk has been replaced and the data has been re-mirrored. A failure in the remaining 
disk before the failed disk is replaced will result in the loss of data described in the “Risks of Lost 
Data If a Non-RAID Hard Disk Fails” section on page 3-2.

 • If the failure occurs in a RAID 5 array, fault tolerance will be maintained, but the loss of a disk will 
cause performance to be severely affected until the failed disk is replaced.

Risks of Lost Data If a Non-RAID Hard Disk Fails
If a non-RAID hard disk fails, you may lose some data when database files and logs are stored on the 
same hard disk, as follows:

 • If both the Cisco Unity SQL Server database and log files are stored on the failed hard disk, you will 
lose all changes to Cisco Unity configuration data that were made since the last backup (for 
example, call handlers and templates) and all logs that were written since the last backup.

 • If Cisco Unity is installed on the failed hard disk, you will lose changes to greetings and recorded 
names that were made since the last backup.

 • If Cisco Unity is installed on the failed hard disk and if any voice messages are in the Unity Message 
Repository (UMR) when the hard disk fails (because, for example, the network connection to the 
partner Domino server was down), you will lose those messages.

 • If Windows 2000 Server is installed on the failed hard disk, you will lose changes to the registry that 
were made since the last backup, including some Cisco Unity configuration settings.

Risks of Lost Data If a Server Is Stolen or Destroyed
If the Cisco Unity server is stolen or destroyed and if it contains more than one hard disk, the data loss 
may be much greater than the data loss caused by failure of a hard disk.
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 • If the message store directory database is stored only on the Cisco Unity server, you will lose all 
changes to the directory that were made since the last backup (for example, new subscribers, 
changes to existing subscribers, and deletions of subscribers).

 • You will lose all changes to Cisco Unity configuration data that were made since the last backup (for 
example, call handlers, templates, and other data stored in the Cisco Unity SQL Server databases).

 • You will lose changes to greetings and recorded names that were made since the last backup.

 • If any voice messages are in the Unity Message Repository (UMR) (because, for example, the 
network connection to the partner Domino server was down), you will lose those messages.

 • You will lose changes to the registry that were made since the last backup, including some 
Cisco Unity configuration settings.

Considerations for Choosing Backup Software
There are many backup software packages—which are sometimes referred to as data protection software 
packages—available for backing up all of the data on the Cisco Unity server, including SQL 
Server/MSDE, and Domino databases and transaction logs. You can also configure backup software 
packages to back up software that is installed on the server.

We recommend that you use a backup software package to back up a Cisco Unity server rather than using 
the Cisco Unity Disaster Recovery tools (DiRT) for the following reasons:

 • DiRT is intended as a tool to be used only for upgrading Cisco Unity software and for migrating to 
another directory or configuration. Backup software is designed for use in a comprehensive backup 
strategy.

 • DiRT requires that the Cisco Unity software be stopped in order to back up all Cisco Unity data 
reliably. Backup software can back up the Cisco Unity server while Cisco Unity continues to run.

 • DiRT backs up only Cisco Unity data. Backup software does not have this limitation.

 • DiRT cannot back up software installed on the Cisco Unity server, so restoring the server from a 
DiRT backup may require additional time. Backup software can back up both software and data.

 • DiRT is not supported for backing up the Cisco Unity Bridge. Backup software is supported for 
backing up the Cisco Unity Bridge.

Preparations for Backing Up a Cisco Unity System
To ensure that your backups will be usable in the recovery of all data in the event of a hardware failure 
or the catastrophic loss of the Cisco Unity server, consider all the issues described in the following 
sections:

 • Optimization of the Location of Database and Log Files on a Multi-Array Cisco Unity Server, page 
3-4

 • Documentation of the Cisco Unity Installation, page 3-4

 • Hard Disk Monitoring, page 3-4

 • Inventory of Spare Hard Disks and Servers, page 3-5

 • Storage of Backup Tapes and Software Necessary to Reinstall Cisco Unity, page 3-5

 • Installation of a Tape Drive, page 3-5

 • SQL Server/MSDE Database Backups Schedules (SQL Server Nightly and Weekly Jobs), page 3-5
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Optimization of the Location of Database and Log Files on a Multi-Array 
Cisco Unity Server

To improve performance and to safeguard data if a hard disk fails, the Cisco Unity Installation Guide 
includes information on the hard disk or partition on which to install Windows 2000 Server, Cisco Unity, 
SQL Server, and other required software on supported Cisco Unity servers. (Installing Domino on the 
Cisco Unity server is not supported.) In addition, the Cisco Unity Installation Guide includes 
instructions for moving databases and transaction logs to different hard disks or partitions. Refer to the 
installation guide for your Cisco Unity 4.0(5) configuration at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

Documentation of the Cisco Unity Installation
It is important to make a list of the following information, and keep this information up to date when you 
upgrade Cisco Unity or install new service packs or hot fixes. We recommend that you also keep this 
information for the partner Domino server. Put the lists where you can find them quickly in an 
emergency:

 • Specifications on the servers, including:

 – The amount of RAM

 – The processor type and speed

 – The voice card model, if applicable

 – The tape drive brand and model, if applicable

 – The sizes of the hard disks

 • The computer (NetBIOS) name

 • If you are not using DHCP, the IP address, subnet mask, and default gateway of the server, and the 
IP addresses of the preferred and alternate DNS servers

 • The domain that the server belongs to, if the server is not a domain controller

 • The RAID configuration

 • Details on hard disk partitions, including volume names and partition size

 • A list of software installed on each partition, including exact version numbers (note that backups 
can only be used to recover data for the exact version of Cisco Unity that was backed up)

 • A list of databases and log files stored on each partition

 • Contact information for hardware and software vendors

Hard Disk Monitoring
We recommend that you monitor the hard disks in the Cisco Unity server to verify that they are 
functioning, and to be alerted as soon as possible if they fail. For each server that has been qualified for 
use as a Cisco Unity server, a monitoring application (for example, Compaq InsightManager, Dell 
OpenManage IT Assistant and Server Administrator, and IBM Director) is available that you can use to 
monitor the health of hard disks and other server components. These applications have been qualified 
for limited use on the Cisco Unity server—they are qualified only for remotely restarting the server. 
However, some sites have been using other features without encountering any problems.
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For more information on monitoring Cisco Unity, see the “Performance Monitoring” chapter.

Inventory of Spare Hard Disks and Servers
Not all RAID disks are compatible with one another, and only selected servers have been qualified for 
use as Cisco Unity servers. If you have spare servers that you can cannibalize for parts or that you can 
convert to a Cisco Unity server in an emergency, you need not maintain an inventory of spare hardware. 
Or you may want to keep spare parts and even a spare server on hand to speed recovery. Cisco also offers 
disk and memory field replacement units (FRUs) for its MCS servers.

For detailed information, refer to the Cisco Unity Supported Platforms List, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_data_sheets_list.html.

Storage of Backup Tapes and Software Necessary to Reinstall Cisco Unity
We recommend that you store backup tapes at a location separate from your Cisco Unity installation, but 
preferably near by.

When selecting a fireproof safe or vault for archiving backup media, the most important factor is the 
internal temperature specification. We strongly recommend consulting with your archival or fire 
protection vendor for detailed recommendations and safety standards.

Caution Store all software in a safe place regardless of the backup software you are using. For example, you may 
not be aware that a backup failed, and you may need to reinstall all software even if you are making full 
backups.

Installation of a Tape Drive
If the Cisco Unity server is not connected to the network, install a tape drive in the server. If the server 
is connected to the network, you can install the tape drive or another backup device almost anywhere, 
though the server used for backup must have a Fast Ethernet or Gigabit Ethernet connection path to the 
Cisco Unity server.

SQL Server/MSDE Database Backups Schedules (SQL Server Nightly and 
Weekly Jobs)

By default, a differential backup of the Cisco Unity SQL Server/MSDE database occurs daily, Monday 
through Saturday, at 2:00 a.m., and a full backup occurs every Sunday at 3:00 a.m. It is important to 
confirm that the SQL Server/MSDE database backup does not overlap the backup of the Cisco Unity 
server.
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Backups of the Cisco Unity System
The following sections provide information about using backup software to back up the Cisco Unity 
system:

 • General Requirements, page 3-6

 • Installation of Backup Software, page 3-6

 • Options for Backup and Media Rotation Methods, page 3-7

 • Backups of the Cisco Unity Server, page 3-7

 • Backups of Separate Message Store Servers, page 3-8

 • Backups of Cisco Unity Servers That Are Configured for Failover, page 3-8

 • When to Schedule a Backup, page 3-8

General Requirements
 • A supported version of the backup software. Refer to the “Supported Backup Software” section of 

the Cisco Unity System Requirements, and Supported Hardware and Software, available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/sysreq/40_sysrq.htm. Use of 
backup software not specifically listed as supported is addressed in the “Support Policy for Backup 
Software” section of the Cisco Unity System Requirements, and Supported Hardware and Software 
document.

 • Backup software agent for Domino (if you want to back up the Domino and Cisco Unity servers 
together).

 • Backup software Agent for SQL Server (also required for MSDE).

 • A backup device (for example, a tape drive) and backup media (for example, tapes) compatible with 
the backup device.

In addition, note the following:

 • If the backup device is not installed on the Cisco Unity server, the backup software remote access 
agent is required.

 • Do not use any Open File feature that the backup software has, as it is suitable only for simple file 
system open file operations. The Open File feature cannot reliably back up all database data.

 • Do not attempt to back up a corrupted Cisco Unity database. A backup of a corrupted database 
cannot be used to restore a Cisco Unity server.

Installation of Backup Software
You install backup software and the backup software agents for Microsoft SQL Server (also required for 
MSDE) and for Domino on the server on which the tape drive or other backup device is installed. If the 
backup device is not installed on the Cisco Unity server, you must install the backup software remote 
access agent for Windows NT/2000 on the Cisco Unity server. You may need to restart the server after 
you install the software. For more information, refer to the manufacturer documentation.
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Options for Backup and Media Rotation Methods
Backup software offers a number of backup methods, including backing up all files (full or normal 
backups), and various methods of backing up files that have changed since the last backup (differential 
and incremental backups). Full or normal backups include all specified files, regardless of when they 
were last modified or backed up. Differential backups include all files that changed since the last full 
backup. Incremental backups include only the files that changed since the last backup of any kind. As 
you choose a backup method, keep in mind how your choice affects the restore process:

 • If you always do full backups, you will need to restore only the most recent full backup to 
completely restore the system.

 • If you do both full backups and differential backups, you need to restore only the most recent full 
backup plus the most recent differential backup.

 • If you do both full backups and incremental backups, you need to restore the most recent full backup 
plus all subsequent incremental backups. The more incremental backups you have done since the 
last full backup, the longer it will take you to get Cisco Unity working again.

Note The incremental backup is the only partial backup method that resets the archive bit (an NTFS file 
attribute). Differential backups do not reset the archive bit, so all files that have changed since the last 
full backup are backed up, not just those that have changed since the last incremental backup. 
Differential backups may take longer than incremental backups. However, having a differential backup 
will save time in the event of a restore, because you will need to restore only the last full and the last 
differential backups.

Backup software documentation typically includes a definition of backup methods offered and 
information on how to choose among them according to your circumstances. We recommend that you 
read the documentation before choosing a backup method.

Closely tied with the backup method is the media rotation method. When you choose a media rotation 
method, you must do the following:

 • Choose the backup method to use each day (for example, differential backups Monday through 
Thursday and full backups on Friday).

 • Determine how much backup media (for example, number of tapes) are required each day for the 
selected backup method (for example, one tape each day for the differential backups, three tapes on 
Friday for the full backup).

 • Choose how often the backup media are rotated out of the backup device and taken to an offsite 
storage location.

Backups of the Cisco Unity Server
Note the following stipulations for backing up the Cisco Unity server. For more information, refer to the 
backup software Help.

 • Back up all data and software on all drives on the Cisco Unity server. Having backups of all data 
and software will reduce the amount of time required to get Cisco Unity running again if a 
non-RAID hard disk fails or if the Cisco Unity server is stolen or destroyed. Refer to the backup 
software documentation for detailed instructions on backing up data and software for your 
configuration.
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 • Do online backups only. This requirement means that you must purchase and use the third-party 
backup software agents for Domino and for SQL Server, which allow you to back up open database 
files. Do not use the backup software open file feature for backing up open files. (Note that offline 
backups are supported for the Cisco Unity Bridge. See the “Backing Up a Cisco Unity Bridge 
Server” section on page 3-9.)

 • Configure the backup software to verify the backup, which ensures that the backup tape or other 
media can be read after the backup is finished.

 • Back up all data and software on the Cisco Unity server both before and after you install or upgrade 
any software on the server.

Note that backing up Cisco Unity does not require custom settings in backup software. For information 
on any special backup requirements associated with other third-party software that is installed on the 
Cisco Unity server (for example, virus-scanning software), refer to the manufacturer documentation.

Backups of Separate Message Store Servers
If Cisco Unity is configured for Unified Messaging, back up the Domino server on which Cisco Unity 
subscribers are homed by using the recommendations in the backup software documentation.

Backing up a Domino server that includes Cisco Unity voice messages and directory information does 
not require any custom settings in the backup software.

Backups of Cisco Unity Servers That Are Configured for Failover
The procedure for backing up a secondary Cisco Unity server is the same procedure used to back up the 
primary server. Refer to the manufacturer documentation for detailed instructions for doing backups. In 
a failover configuration, neither the primary nor the secondary server backup includes messages, which 
are held on a separate message store server. Consequently, backing up data on the secondary server does 
not replace a comprehensive strategy for backing up and restoring messages on other servers that are part 
of the Cisco Unity system.

Note that a backup of the database on the primary server has SQL replication links that will be broken 
if this database is restored to a new server, thus requiring extra steps to clean up the broken SQL links. 
For these steps, refer to Cisco Unity Disaster Recovery tools (DiRT) Help.

When backup software is configured for system state backups, the backups include information 
concerning the specific server that the data was backed up from, unless a virtual server name is used.

We recommend that you set up regularly scheduled backups of both primary and secondary servers. Do 
not make changes in the Cisco Unity Administrator, or record greetings or subscriber names, while 
backups are being created.

When to Schedule a Backup
Backup software generally includes options for scheduling backups to occur automatically at a specified 
time. Select a time when the Cisco Unity server is processing a low volume of calls (for example, after 
the end of the regular business day), and when there are no other processes running (for example, do not 
schedule a backup concurrently with running a virus scan or generating reports). If you are using the 
Cisco Unity Bridge, VPIM, or AMIS, schedule backups for a time that will not overlap with message 
delivery.
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Depending on how much data needs to be backed up, and in a failover configuration, whether you are 
backing up all data on the primary and secondary servers, the backup could take several hours. When 
scheduling backups, allow enough time for the backup to finish before the beginning of the next business 
day, at which time Cisco Unity again becomes busy answering calls.

Caution If the Cisco Unity server is scheduled to reboot periodically, ensure that the reboot does not occur during 
the time when the server is being backed up. If the server reboots during a backup, the backup will not 
be complete.

Backing Up a Cisco Unity Bridge Server
You can use backup software to back up data on the Cisco Unity Bridge server, or you can back up files 
manually. The Cisco Unity Disaster Recovery tools (DiRT) are not supported for use with the Bridge.

Both offline and online backups are supported for the Cisco Unity Bridge server. When backing up the 
Bridge server, you need to back up only the configuration and data files; you do not need to back up the 
Bridge software because it is easy to reinstall the Bridge software on another server. The files that you 
back up on the Bridge server include:

 • WAV files of voice names for Octel and Unity node directory entries

 • A database that contains configuration data and information about Octel and Unity node directory 
entries

 • Configuration files

Considerations for Testing Backups
We recommend that you thoroughly test backing up and restoring your Cisco Unity servers in a test 
environment before using the backup software on a production system, and then run similar tests in the 
production environment so that you can refine your backup strategy as necessary. Consider the following 
suggestions:

 • Verify that the schedule you set in the backup software allows sufficient time for the backup to 
complete before the next business day, and that the backup medium has sufficient storage space.

 • Keep in mind that if this is a new installation with little data in the SQL Server and in the Domino 
databases, your test backups will probably be much smaller and take significantly less time than 
when the server has been in service for a while.

 • After running the backup software, check the event log for backup-related errors.
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Routine and Scheduled Maintenance on the 
Cisco Unity Server

Forwarding Unaddressed Messages to the Correct Recipients
In some situations, messages left in Cisco Unity are not associated with a specific recipient, and 
therefore they must be screened and routed to the applicable subscriber or call handler. At least one 
subscriber should be assigned the responsibility of reviewing these messages frequently and forwarding 
them to the applicable recipients. The following sections provide information on managing these 
messages:

 • Unaddressed Messages Distribution List, page 4-1

 • Messages Left in the Operator, Opening Greeting, and Goodbye Call Handlers, page 4-2

 • Messages Left in the Example Interview, page 4-2

Unaddressed Messages Distribution List
Messages that cannot be delivered because the network or a server assigned to a subscriber has gone 
off-line, or is otherwise unavailable to the Cisco Unity server, are forwarded to the Unaddressed 
Messages distribution list. By default, this distribution list contains the Example Administrator as its 
only member.

To route these messages properly, verify that the Unaddressed Messages distribution list has at least one 
member (such as the operator) who will monitor the mailbox and handle messages that cannot be 
delivered. To add subscribers to the distribution list, do the “To Add Subscribers to the Unaddressed 
Messages Distribution List” procedure. (For information about public distribution lists, refer to the 
“Public Distribution List Settings” chapter in the Cisco Unity System Administration Guide. The guide 
is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.htm.)

To Add Subscribers to the Unaddressed Messages Distribution List

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Public Distribution Lists page.

Step 2 Click the Find icon.

Step 3 Double-click the Unaddressed Messages distribution list.
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Step 4 Change settings as applicable, and then click the Save icon.

Messages Left in the Operator, Opening Greeting, and Goodbye Call Handlers
When a caller to Cisco Unity dials the operator and no operator is available, the caller can leave a 
message, depending on the call transfer settings for the Operator call handler. Call transfer settings in 
the Opening Greeting and Goodbye call handlers can also allow callers to leave a message. By default, 
messages left in any of these call handlers are sent to the Unaddressed Messages distribution list. For 
more information on call handler message recipient settings, refer to the “Call Handler Settings” chapter 
in the Cisco Unity System Administration Guide. The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.htm.

Messages Left in the Example Interview
When callers are routed to the Example Interview, which gathers basic information about who they are 
and who they are trying to reach, the answers to the questions are routed to the indicated recipient. 
Choose a subscriber (such as the operator) or a distribution list as the recipient. For information on 
choosing an interview response recipient, refer to the “Interview Handler Settings” chapter in the 
Cisco Unity System Administration Guide. The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.htm.

Scanning for Viruses

Selecting Virus-Scanning Software
For a list of the virus-scanning software that has been qualified for use with Cisco Unity, refer to 
Cisco Unity System Requirements, and Supported Hardware and Software, available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/sysreq/40_sysrq.htm.

Excluding Cisco Unity Directories from Scanning
To significantly improve Cisco Unity performance, exclude from virus scanning the directory in which 
Cisco Unity is installed (the default directory is CommServer), and all subdirectories under that 
directory. Refer to the virus-scanning software Help for information on excluding directories from 
scanning.

Scheduling Virus Scanning
Schedule virus scanning to occur daily. Ideally, virus scanning should occur when the server is least busy 
so that it does not interfere with Cisco Unity voice messaging functions.
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Updating Virus-Scanning Definitions
Your virus-scanning software should be configured to alert you every week or two to check the 
manufacturer website for new virus-scanning definitions. If you already have a policy for updating these 
definitions on the other computers on your network, follow the same policy for the Cisco Unity server. 
If you do not already have a policy, we recommend that you download and install the new definitions on 
the Cisco Unity server when the software prompts you to do so.

Running the DbWalker Utility
The Cisco Unity Directory Walker (DbWalker) utility checks each call handler, subscriber, subscriber 
template, interview handler, location object, and directory object in the Cisco Unity database for missing 
values, broken links, and other problems. DbWalker must be run on the Cisco Unity server. It cannot be 
run off-box.

The utility runs in two modes: scheduled and manual. Scheduled mode provides a read-only review of 
the database. When the utility is run in manual mode, you can make automatic database repairs by using 
site-specific information.

Both scheduled and manual modes create an output log file. The log file lists any errors found, shows 
any automatic repairs that have been made to missing values and broken links, and also gives advisory 
warning messages for any items that require investigation and that may require a manual repair. The log 
file can be sent to a system manager or designated subscriber via e-mail, provided that the site security 
configuration allows this. The DbWalker utility also offers a choice for log file output content. We 
recommend that you set the utility to report only errors and warnings rather than a complete list of the 
entire database, because the output file may otherwise be unmanageably large.

Schedule the DbWalker utility to run monthly, in read-only mode. Following each monthly scheduled 
run, the following two database maintenance tasks must be done:

 • Review the output log file.

 • Promptly resolve any errors. Run the DbWalker utility a second time in manual mode; the utility will 
correct the errors it is able to resolve, by making use of the site-specific information you provide. If 
any errors remain that the utility cannot resolve, you can fix them by making corrections in the 
Cisco Unity Administrator.

To Schedule the DbWalker Utility to Run Monthly (Read-Only)

Step 1 On the Cisco Unity desktop, confirm that Cisco Unity is running, then double-click the Cisco Unity 
Tools Depot icon.

Step 2 In the left pane, under Diagnostic Tools, double-click DbWalker.

Step 3 On the Directory Walker page, in the Options list, confirm that no check boxes are checked.

Step 4 In the Logging section, enter the location of your choice for the output log files.

Step 5 Choose a Logging Detail method. We recommend you choose Log Only Information About Objects 
with One or More Errors.

Step 6 To send the monthly output log file to the system manager or to a designated subscriber, click 
Schedule > E-Mail Notification.

Step 7 Enter a valid subscriber e-mail address, then click Send Test Message.

Step 8 Verify that the test e-mail message is received.
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Note that firewalls and other site security measures may prevent e-mail message receipt.

Step 9 Click Save.

Step 10 On the Directory Walker page, click Schedule > Schedule DbWalker to Run.

Step 11 In the DbWalker Scheduler window, click Schedule Walk.

Step 12 Click OK to accept the default task name, or enter the task name of your choice.

Step 13 In the DbWalker window, on the Tasks tab, check the Enabled check box, and complete the remaining 
fields as needed for your site.

Step 14 Click the Schedule tab, choose Schedule Tasks Monthly, and complete the remaining fields as needed 
for your site.

Step 15 Click the Settings tab, and complete the fields as needed for your site.

Step 16 Click Apply, click OK, and then click Close.

The DbWalker utility will run as scheduled.

Step 17 When the DbWalker utility has run, review the DbWalker output log file. Investigate all errors and 
warning messages. Resolve any missing or incorrect information in the database by doing the following 
“To Run the DbWalker Utility Manually (With Database Repairs)” procedure, and by using the 
Cisco Unity Administrator.

To Run the DbWalker Utility Manually (With Database Repairs)

Step 1 On the Cisco Unity desktop, confirm that Cisco Unity is running, then double-click the Cisco Unity 
Tools Depot icon.

Step 2 In the left pane, under Diagnostic Tools, double-click DbWalker.

Step 3 In the Options list, select the automatic repairs that you want the utility to perform.

Step 4 In the Logging section, confirm the location and the Logging Detail method for the output log file. We 
recommend you choose Log Only Information About Objects with One or More Errors.

Step 5 Click Walk Database.

The DbWalker utility will run and any automatic repairs that were selected will be done.

Step 6 When the DbWalker utility has run, review the output log file. Investigate all errors and warning 
messages. Resolve any missing or incorrect information in the database by using the Cisco Unity 
Administrator.

Updating the System Clock
When the Cisco Unity server is connected to the network, we recommend that you configure an 
authoritative time server to ensure that all computers in the organization use a common time. Refer to 
Article ID 216734 (“How to Configure an Authoritative Time Server in Windows 2000”) on the 
Microsoft support website.

When the system clock on the Cisco Unity server is slow by a significant amount, subscribers may 
believe that Cisco Unity is delaying message delivery.
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If the Cisco Unity server is not connected to the network, check the system clock monthly to ensure that 
the time is accurate to within a minute. To change the time, use the Date/Time Control Panel (on the 
Windows Start menu, click Settings > Control Panel > Date/Time).

Do not change the time on the system clock while you are using the Cisco Unity Administrator, or you 
may encounter inconsistencies in the data. This is due to an IIS caching problem. In this circumstance, 
new values will have been written to the SQL Server database, but old values will still appear in the IIS 
cache. This causes the Cisco Unity Administrator to appear to show that you have not changed values 
that you did in fact change.

Restarting the Cisco Unity Server
Depending on how your network is configured, Cisco Unity services may rely on the availability of a 
number of other servers on the network, as follows:

 • The server that homes the Unity System mailbox

 • The server(s) that home Cisco Unity subscriber mailboxes

 • Lotus Domino server

 • The domain controller for the domain in which the Cisco Unity server belongs

 • The Active Directory global catalog server

 • The Cisco CallManager server (if Cisco Unity is integrated with Cisco CallManager)

 • The Cisco Unity secondary server, when Cisco Unity is configured for failover

The availability of each of these servers, the network connection to these servers, and the corresponding 
components on the Cisco Unity server may each affect Cisco Unity services.

When you restart servers or network devices on a regular schedule, include Cisco Unity servers in this 
schedule.

The Unity Schedule Restart tool, available in Tools Depot, allows you schedule an automatic restart of 
the Cisco Unity server, or just the Cisco Unity services. We recommend that you use the Unity Schedule 
Restart tool to schedule automatic restarts of the Cisco Unity server. Note that you can also use the tool 
to view Application Event log entries related to restarting Cisco Unity.

To Schedule Cisco Unity Restarts

Note that if you want to change an existing schedule rather than create a new one, delete the task and 
schedule a new task, as shown in the following steps.

Step 1 On the Cisco Unity desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Schedule Unity Restart.

Step 3 In the Configure Scheduled Restart Options window, choose to restart the Cisco Unity server or to restart 
Cisco Unity services only.

We recommend that you restart the Cisco Unity server rather than restarting individual services.

Step 4 Click Schedule Restart, and complete the fields as needed for your site.

Step 5 Click Save and Exit.
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Monitoring the Message Transfer Agent
Monitor the MTA (UnityMTA and UnityMTA\Failed directories) periodically to confirm that messages 
are going to the applicable subscriber home servers. The MTA queue can contain messages that did not 
go to subscriber home servers for the following reasons: there has been a loss of network connectivity; 
the Domino server has gone off-line; or, there is a DNS issue (if the name of either the sending server or 
the home server cannot be resolved, the messages cannot be sent to the home server.)
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Cisco Unity Data and Log Files

Introduction to Cisco Unity Data and Message Storage
Information about subscriber accounts and other Cisco Unity data is stored in a SQL Server database on 
the Cisco Unity server. Additionally, a small subset of the Cisco Unity information is stored in the 
Domino directory. Cisco Unity keeps the information in the Domino directory and in the SQL Server 
database synchronized.

By storing its data in a SQL Server database, Cisco Unity derives many performance, reliability, and 
scalability benefits. Because very little information is stored in the Domino directory, and because that 
information is not likely to change often, directory replication caused by changes to Cisco Unity data is 
minimal after the initial creation of subscriber accounts.

Cisco Unity Functions When the Network Is Down
In addition to the SQL database that contains subscriber names and extensions, the Unity Messaging 
Repository (UMR) is also on the Cisco Unity server. When a Domino server or even the entire Domino 
network is down, Cisco Unity can answer calls, allow unidentified callers to look up subscriber 
extensions, and take voice messages. While the e-mail system or network is off line, new voice messages 
are stored in the UMR on the Cisco Unity server. When the Domino server or network is back on line, 
the voice messages stored in the UMR are routed to the subscriber mailboxes.

Note that the UMR conversation is disabled by default. If you are running Domino without clustering, 
you can enable the UMR conversation. (If you run Domino with clustering, you are already protected 
from circumstances in which there could be problems with the availability of messages.) You use the 
Advanced Settings tool in Tools Depot to enable the UMR conversation. The setting is called 
Conversation—(Unity Domino only) Enable UMR Conversation. For detailed instructions, refer to the 
Advanced Settings tool Help.

Managing the Location of Log Files and Database Files
The way in which logical drives on the Cisco Unity server are partitioned and what content is located on 
the drives depends on the size of the Cisco Unity system and the RAID volume configuration used.

The partition and drive content recommendations from the Cisco Unity Installation Guide should 
continue to be followed when maintaining your system.
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Moving Subscriber Mailboxes
From time to time you may need to move subscriber mailboxes to another server that is faster or has more 
disk space available, or you may want to move mailboxes when you add new servers to your network. It 
is possible to move subscribers between servers without having to shut down Cisco Unity.

Caution If you are moving a group of subscriber mail files at once, confirm that you do not inadvertently select 
the Unity Messaging System, UAmis, or UOmni mail files. To move these special mail files, see the 
“Moving the Unity Messaging System, UAmis, and UOmni Mail Files” section on page 5-3.

To Move Subscriber Mail Files Between Servers

Step 1 Follow the Lotus Domino procedures for moving mail files between servers.

Step 2 Verify that the new mail file has been created on the destination server, and that the subscriber Person 
document has been updated with the new mail server name in the directory replica on the Domino server 
that Cisco Unity monitors. (This is the Domino server that was selected in the Message Store 
Configuration wizard during Cisco Unity setup.)

Step 3 If the destination server contains at least one other Cisco Unity subscriber mail file associated with the 
same Cisco Unity server, skip to Step 5.

If the destination server does not contain at least one other Cisco Unity subscriber mail file associated 
with the same Cisco Unity server, notifications will not be sent when activity occurs on that subscriber 
mail file, including MWI notifications. To fix the problem, continue with Step 4.

Step 4 Do one of the following (each action will result in the identical result, so do the one that is most 
convenient to you):

 • Restart the Cisco Unity server.

 • Wait for the next scheduled MWI resynchronization. By default, MWIs are resynchronized each day 
at midnight, but the time can be changed in the Cisco Unity Telephony Integration Manager (UTIM).

 • Use UTIM to resynchronize MWIs, as follows:

 – On the Windows Start menu of the Cisco Unity server, click Programs > Cisco Unity > 
Manage Integrations.

 – Expand the tree in the left pane.

 – Click Properties.

 – In the Integration section of the properties page, click Resynchronize Now.

 – Exit UTIM.

Step 5 Verify that Cisco Unity has become aware of the new location of the mail file, which occurs after 
Cisco Unity synchronizes its database with the Domino directory. Cisco Unity synchronizes with the 
Domino directory every minute, but you can verify that the synchronization has occurred by using the 
Cisco Unity Data Link Explorer (CUDLE) tool, as follows:

a. On the Cisco Unity server, double-click the Cisco Unity Tools Depot icon on the desktop.

b. In the left pane, expand Diagnostic Tools.

c. Double-click Data Link Explorer.

d. Click View > Query Builder.
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e. In the Query Builder window, enter the following text: select alias, homeserver from subscriber 
where alias = ‘ShortName’

For ShortName, enter the short name of the subscriber whose mail file you just moved, enclosing the 
short name in single quotes.

f. Click Execute.

g. In the results pane, verify that the homeserver field has been updated.

h. Close the Query Builder window and exit CUDLE.

Moving the Unity Messaging System, UAmis, and UOmni Mail 
Files

The Unity Messaging System, UAmis, and UOmni mail files are used for specific functions in 
Cisco Unity. You use the same procedures to move these special mail files that you use to move ordinary 
subscriber mail files—but with a few extra steps to prevent problems that can occur after the mail files 
are moved.

The following sections describe the mail files and how to move them correctly:

 • Unity Messaging System Mail File, page 5-3

 • UAmis Mail File, page 5-4

 • UOmni Mail File, page 5-6

Unity Messaging System Mail File
When an unidentified caller—an outside caller or a caller from inside the organization who is calling 
from a phone that is not associated with a subscriber account (such as a conference room)—leaves a 
message for a subscriber, Cisco Unity gives the message to the subscriber home server and stores it in 
the subscriber mail file. Such messages are identified as coming from the Unity Messaging System mail 
file, which is homed on the server that Cisco Unity gives the message to, and has the display name Unity 
Messaging System.

For more information on the Unity Messaging System mail file and its associated account, refer to the 
“Default Accounts and Message Handling” chapter in the Cisco Unity System Administration Guide. The 
guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.htm.

To Move the Unity Messaging System Mail File

Step 1 Follow the Lotus Domino procedures for moving mail files between servers.

Step 2 Verify that the new mail file has been created on the destination server, and that the Person document 
has been updated with the new mail server name in the directory replica on the Domino server that 
Cisco Unity monitors. (This is the Domino server that was selected in the Message Store Configuration 
wizard during Cisco Unity setup.)

Step 3 If the destination server contains at least one other Cisco Unity subscriber mail file associated with the 
same Cisco Unity server, skip to Step 5.
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If the destination server does not contain at least one other Cisco Unity subscriber mail file associated 
with the same Cisco Unity server, notifications will not be sent when activity occurs on that subscriber 
mail file, including MWI notifications. To fix the problem, continue with Step 4.

Step 4 Do one of the following (each action will result in the identical result, so do the one that is most 
convenient to you):

 • Restart the Cisco Unity server.

 • Wait for the next scheduled MWI resynchronization. By default, MWIs are resynchronized each day 
at midnight, but the time can be changed in the Cisco Unity Telephony Integration Manager (UTIM).

 • Use UTIM to resynchronize MWIs, as follows:

 – On the Windows Start menu of the Cisco Unity server, click Programs > Cisco Unity > 
Manage Integrations.

 – Expand the tree in the left pane.

 – Click Properties.

 – In the Integration section of the properties page, click Resynchronize Now.

 – Exit UTIM.

Step 5 Verify that Cisco Unity has become aware of the new location of the mail file, which occurs after 
Cisco Unity synchronizes its database with the Domino directory. Cisco Unity synchronizes with the 
Domino directory every minute, but you can verify that the synchronization has completed by using the 
Cisco Unity Data Link Explorer (CUDLE) tool, as follows:

a. On the Cisco Unity server, double-click the Cisco Unity Tools Depot icon on the desktop.

b. In the left pane, expand Diagnostic Tools.

c. Double-click Data Link Explorer.

d. Click View > Query Builder.

e. In the Query Builder window enter the following text: select alias, homeserver from subscriber 
where alias = ‘Unity_<ServerName>’

For ServerName, enter the Cisco Unity server name for the Unity Messaging account, enclosing the 
Unity_<ServerName> in single quotes.

f. Click Execute.

g. In the results pane, verify that the homeserver field has been updated.

h. Close the Query Builder window and exit CUDLE.

Step 6 If you did not restart the Cisco Unity server in Step 4, messages from unidentified callers may become 
stuck in the Unity Messaging Repository (UMR). Do the following sub-steps to prevent the problem:

a. On the Windows Start menu, click Programs > Administrative Tools > Services.

b. From the Services window, stop and restart the AvUMRSyncSvr service.

UAmis Mail File
Outgoing AMIS messages are placed in a Domino mail file that has the name UAmis_<Servername>. 
For more information on the UAmis mail file, refer to the “UAmis Account” section in the “AMIS 
Networking” chapter of the Networking in Cisco Unity Guide. The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/net/net405/dom/index.htm.
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To Move the UAmis Mail File

Step 1 Follow the Lotus Domino procedures for moving mail files between servers.

Step 2 Verify that the new mail file has been created on the destination server, and that the Person document 
has been updated with the new mail server name in the directory replica on the Domino server that 
Cisco Unity monitors. (This is the Domino server that was selected in the Message Store Configuration 
wizard during Cisco Unity setup.) 

Step 3 If the destination server contains at least one other Cisco Unity subscriber mail file associated with the 
same Cisco Unity server, skip to Step 5.

If the destination server does not contain at least one other Cisco Unity subscriber mail file associated 
with the same Cisco Unity server, continue with Step 4.

Step 4 Do one of the following (each action will result in the identical result, so do the one that is most 
convenient to you):

 • Wait for the next scheduled MWI resynchronization. By default, MWIs are resynchronized each day 
at midnight, but the time can be changed in the Cisco Unity Telephony Integration Manager (UTIM).

 • Use UTIM to resynchronize MWIs, as follows:

 – On the Windows Start menu of the Cisco Unity server, click Programs > Cisco Unity > 
Manage Integrations.

 – Expand the tree in the left pane.

 – Click Properties.

 – In the Integration section of the properties page, click Resynchronize Now.

 – Exit UTIM.

Step 5 Verify that Cisco Unity has become aware of the new location of the mail file, which occurs after 
Cisco Unity synchronizes its database with the Domino directory. Cisco Unity synchronizes with the 
Domino directory every minute, but you can verify that the synchronization has completed by using the 
Cisco Unity Data Link Explorer (CUDLE) tool, as follows:

a. On the Cisco Unity server, double-click the Cisco Unity Tools Depot icon on the desktop.

b. In the left pane, expand Diagnostic Tools.

c. Double-click Data Link Explorer.

d. Click View > Query Builder.

e. In the Query Builder window enter the following text: select alias, homeserver from subscriber 
where alias = ‘UAmis_<ServerName>’

For ServerName, enter the Cisco Unity bridgehead server name for the UAmis account, enclosing the 
server name in single quotes.

f. Click Execute.

g. In the results pane, verify that the homeserver field has been updated.

h. Close the Query Builder window and exit CUDLE.

Step 6 Restart the Cisco Unity server.
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UOmni Mail File
Administrative messages from the Cisco Unity Bridge to create, modify, or delete Bridge subscribers are 
placed in the special mail files that has the display name UOmni_<ServerName>. For more information 
on the UOmni mail file, refer to the “UOmni Account” section in the “About Bridge Networking” 
chapter of the Cisco Unity Bridge Networking Guide. The guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/bridge30/bnet/dom/index.htm.

To Move the UOmni Mail File

Step 1 Follow the Lotus Domino procedures for moving mail files between servers.

Step 2 Verify that the new mail file has been created on the destination server, and that the Person document 
has been updated with the new mail server name in the directory replica on the Domino server that 
Cisco Unity monitors. (This is the Domino server that was selected in the Message Store Configuration 
wizard during Cisco Unity setup.) 

Step 3 If the destination server contains at least one other Cisco Unity subscriber mail file associated with the 
same Cisco Unity server, skip to Step 5.

If the destination server does not contain at least one other Cisco Unity subscriber mail file associated 
with the same Cisco Unity server, notifications will not be sent when activity occurs on that subscriber 
mail file, including MWI notifications. To fix the problem, continue with Step 4.

Step 4 Do one of the following (each action will result in the identical result, so do the one that is most 
convenient to you):

 • Wait for the next scheduled MWI resynchronization. By default, MWIs are resynchronized each day 
at midnight, but the time can be changed in the Cisco Unity Telephony Integration Manager (UTIM).

 • Use UTIM to resynchronize MWIs, as follows:

 – On the Windows Start menu of the Cisco Unity server, click Programs > Cisco Unity > 
Manage Integrations.

 – Expand the tree in the left pane.

 – Click Properties.

 – In the Integration section of the properties page, click Resynchronize Now.

 – Exit UTIM.

Step 5 Verify that Cisco Unity has become aware of the new location of the mail file, which occurs after 
Cisco Unity synchronizes its database with the Domino directory. Cisco Unity synchronizes with the 
Domino directory every minute, but you can verify that the synchronization has completed by using the 
Cisco Unity Data Link Explorer (CUDLE) tool, as follows:

a. On the Cisco Unity server, double-click the Cisco Unity Tools Depot icon on the desktop.

b. In the left pane, expand Diagnostic Tools.

c. Double-click Data Link Explorer.

d. Click View > Query Builder.

e. In the Query Builder window enter the following text: select alias, homeserver from subscriber 
where alias = ‘UOmni_<ServerName>’

For ServerName, enter the Cisco Unity bridgehead server name for the UOmni account, enclosing the 
server name in single quotes.

f. Click Execute.
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g. In the results pane, verify that the homeserver field has been updated.

h. Close the Query Builder window and exit CUDLE.

Step 6 On Cisco Unity bridgehead server, on the Windows Start menu, click Programs > Administrative 
Tools > Services.

Step 7 From the Services window, stop and restart CsBridgeConnector, which is the Bridge Connector service.

The Bridge Connector monitors the UOmni mail file. Restarting it immediately after the mail file move 
ensures that Person files that are associated with Bridge subscribers are created correctly and messages 
do not get stuck in the UOmni mail file. After you have restarted the Connector, Bridge subscribers can 
be added, modified, and deleted without any problems.

Step 8 Restart the Cisco Unity server.
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Performance Monitoring

Introduction to Monitoring Cisco Unity Performance
Performance data is valuable for troubleshooting, predicting future system requirements, and 
administrative monitoring of the Cisco Unity messaging infrastructure. Performance information also 
plays a large part in determining the health and scalability of a Cisco Unity deployment.

Cisco Unity is dependent on the messaging subsystem, which is Lotus Domino. If the messaging 
subsystem fails, goes off line, performs poorly, or otherwise becomes unavailable, unified messaging 
functionality and the performance of Cisco Unity suffers. Because of this dependency on the messaging 
infrastructure, the message store architecture and the design of a Cisco Unity deployment are two of the 
most important factors to consider for performance impact on the user experience.

Defining Performance
In client/server computing, performance is the speed, efficiency, and ultimately the responsiveness of 
computer operations. Traffic flow is a good analogy for computing because the computing system 
logically compares to a traffic grid. Moving a vehicle from one end of a city to the other presents 
particular challenges to transportation efficiency, as does moving data from one end of a computer 
system to another. Issues such as timing, speed, load patterns, queuing, and the efficiency of the system 
all affect the movement of data.

A baseline is the observed and recorded measurement of performance against which comparisons are 
made. Baselines are only useful if they are recorded and then actively compared against past or future 
measurements, for example:

 • Capturing the performance characteristics of a system in order to troubleshoot a particular 
performance problem.

 • Comparing the performance behavior of disparate systems to understand the benefits of one over 
another.

 • As a planning aid for capacity and future growth of production systems.

At the application level, computer performance is usually divided into four performance elements:

 • Memory—the quantity and speed of physical memory available to the system or application being 
measured.

 • Processor—the capability of a system CPU to execute commands in a timely and efficient manner.

 • Disk—the quantity and speed of the physical persistent storage subsystem.

 • Network—the bandwidth and latency involved in transmitting or receiving data from the network.
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There are other factors that can introduce performance degradation, such as heat, electromagnetic 
radiation, and inferior components, but they are for consideration at a lower level of computer design 
and implementation than we are concerned with here.

Determining Performance Expectations
In a unified messaging deployment, user expectations for e-mail and voice messages may not be the 
same. E-mail messaging involves the transmission of text or images within electronic mail that is not 
entirely time-dependent. An acceptable rate of delivery may range from a few seconds to a few minutes. 
In contrast, voice messaging involves the real-time transmission of audio information to a user and 
demands a lower occurrence of delay or latency. What qualifies as acceptable performance can vary from 
site to site, and from user to user. Determining what is required for performance monitoring equates to 
determining and communicating what is acceptable performance.

Sites need to level user assumptions and expectations of messaging performance against the realities of 
business demands. A rock-solid design and implementation plan for the messaging infrastructure is 
usually the best defense against unmet expectations, but problems do still occur. Some common reasons 
for performance issues and unmet expectations include:

 • The expected load on the system was initially incorrect or changed significantly from the original 
design. For example, a successful business expands beyond the projected growth in the original 
deployment plan, and consequently more users are pushing the system beyond the original design 
parameters.

 • The existing e-mail messaging infrastructure cannot meet the performance needs for unified 
communications. This does not necessarily imply that there is an additional overhead created by 
voice communications, just that the tolerances for performance expectations are much lower.

A good measure of how well expectations are being met is to simply ask if the solution provides the 
service requested. From there, the next steps are adding accessibility, speed of response, and other 
site-specific factors. Bear in mind that these questions are some of the most difficult to answer because 
they are subjective:

 • Is the server and/or network performing adequately? How do you define adequate performance?

 • Do users experience unnecessary delays? What constitutes an unnecessary delay?

 • What was the application, server, or network doing during an period of inadequate performance or 
unnecessary delay? Was this planned for? How can the problem be isolated?

Performance Monitoring in an On-Box vs. Off-Box Message 
Store Environment

In the Cisco Unity architecture, it is not required, nor in some configurations is it optimal or even 
supported, to have the Cisco Unity message store on the same physical server hardware (on-box) as the 
Cisco Unity server that conducts voice call processing. (What is commonly referred to as an off-box 
message store configuration is a Cisco Unity system that stores subscriber messages on a separate 
physical server or servers.) An off-box configuration can present a significant performance benefit by 
distributing the performance resources required across multiple systems.

As with any implementation design, there are caveats to the off-box configuration. For example, the 
network on which the communications between Cisco Unity and the message store occur can become a 
bottleneck or point of failure. It is therefore necessary to monitor all of the servers and message stores 
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in use by Cisco Unity for performance issues. To assist in this task, the Cisco Unified Performance 
Information and Diagnostics (CUPID) tool, Microsoft Performance Monitor, and Microsoft 
Management Console (MMC) each allow single-point remote administration of multiple servers.

Permissions Required for Performance Monitoring
Administrative privileges are required for each of the servers to be monitored. Use an administrative 
account, or assign the following minimum permissions to a specific account or group responsible for 
performance monitoring:

 • Log on as a service (for CUPID monitoring)

 • Profile system performance

 • Log on locally (for CUPID configuration and Performance Monitor configuration/monitoring)

 • Profile single process

 • Install Network Provider Monitor (administrative privileges)

It is possible and sometimes necessary to remotely monitor a target system with the Performance 
Monitor. However, issues of service rights for the Performance Logs and Alerts service, and problems 
with network connectivity, can interfere with testing. Therefore, we recommend that performance tests 
be run locally on the target machine when possible.

Configuring the Network Provider Monitor on the Cisco Unity 
Server and Cisco Unity Message Store Servers

To capture network traffic information, it may be necessary to install the Network Monitor Provider. 
Because of the performance impact of the Network Monitor Provider, we recommend collecting data for 
short intervals during periods of off-peak system usage.

To Install the Network Monitor Provider

Step 1 On the Windows Start menu, click Settings > Control Panel > Network and Dial-up Connections > 
<Your Network Adapter Connection>.

Step 2 In the Connection Status dialog box, click Properties.

Step 3 On the General tab in the Connections Properties dialog box, click Install.

Step 4 Select Protocol, then click Add.

Step 5 In the Select Network Protocol Driver window, select Microsoft from the list of manufacturers.

Step 6 Select Network Monitor Driver from the list, then click OK.
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Configuring Cisco Unity Performance Information Tools
Running the CUPID utility or the Performance Monitor on the local server is an active, semi-intrusive 
form of monitoring. However, the effect is mitigated by the large sample interval and relatively small 
application footprint of CUPID or the Performance Monitor. The overhead or load impact of the 
monitoring tools should be minimal and not observable in the analysis of the results.

We recommend that the performance log data be captured to a physical disk or logical volume that does 
not hold either the Cisco Unity executables or the data from Domino or SQL Server, and that has 
sufficient space available for collection of diagnostic trace and log data. Doing so will reduce throughput 
issues on systems with high traffic.

Configuring Cisco Unity Performance Information and Diagnostics (CUPID)
CUPID is a performance and diagnostic information collection utility for Windows 2000. At its core, 
CUPID is an NT service that communicates to the performance subsystem of the Windows Operating 
System, and collects data based on the counters specified in a XML configuration file. CUPID is 
available in Tools Depot for Cisco Unity version 4.0(3) and later. Updates are periodically made 
available for download at http://www.CiscoUnityTools.com.

The configuration file used for CUPID consists of an XML document with several Counter elements that 
define the counters to collect. The configuration files included with the CUPID installation represent the 
latest recommended performance counters to collect when running a performance test. Review the 
configuration file for the specific needs of the system under test as additional counters may be needed 
to monitor a third-party backup or antivirus solution in addition to normal messaging activity.

Note that remote monitoring of Cisco Unity or Cisco Unity message store performance with CUPID is 
not supported. Refer to the CUPID online Help for more information.

To Change CUPID Configuration Settings

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Diagnostic Tools, double-click CUPID. If CUPID has not previously been run on 
this server, install the CUPID service when prompted.

Step 3 Select CUPID configuration options according to the needs of your configuration.

Step 4 Select the XML file that reflects your Cisco Unity configuration or manually create an XML document 
that suits the needs of the configuration to be measured.

To Automatically Start Collection of CUPID Performance Information on System Startup

Step 1 Open the Services Control Panel applet.

Step 2 Select the Cisco Unity Performance Information and Diagnostics service.

Step 3 Right-click the service, then select Properties.

Step 4 Set the Service Startup Type to Automatic.
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Configuring Microsoft Performance Monitor
The Microsoft Management Console (MMC), of which the Performance Monitor is a pair of 
components, is a collection of modular administration tools that allows a centralized interface for many 
different maintenance and managerial functions on a local or remote system. The MMC is flexible 
enough to allow a single point of administration, and to allow custom interfaces or consoles to 
accomplish common tasks.

When working with Cisco Unity, an administrator may need to access elements of the MMC that deal 
with Active Directory Users and Computers, or SQL servers. However, when assessing Cisco Unity 
performance, the Performance Monitor, which is comprised of the System Monitor and the Performance 
Logs and Alerts controls, is the preferred tool for overall analysis.

The System Monitor is an ActiveX control component that can be added to a MMC console or embedded 
within a web page or similar document. The authored console version of the Performance Monitor 
contains both the System Monitor and the Performance Logs and Alerts control. A stand-alone 
executable version is also available from the Windows 2000 Resource Kit.

Note that some elements of Cisco Unity performance may be difficult or impossible to measure through 
the use of the Performance Monitor alone. For example, Message Waiting Indication (MWI) response 
time, message delivery speed, and directory/addressing lookup delays are difficult performance elements 
to measure. Because certain operations depend on the distributed elements of a larger system (such as 
network bandwidth, remote message store server performance, and voice board or integration 
performance), the Performance Monitor may only be able to show a portion of a particular performance 
issue. There may be additional hardware or software tools (such as a network packet analyzer) and 
methods required to obtain the performance information necessary to characterize the complete 
Cisco Unity implementation.

To Start the Performance Monitor as an Authored Console

Step 1 On the Windows Start menu, click Programs > Administrative Tools > Performance.

To Embed Performance Monitoring Capability in an MMC Console

Step 1 On the Windows Start menu, click Run.

Step 2 Enter mmc and then press Enter.

Step 3 On the Application menu, click Console > Add/Remove Snap-In.

Step 4 In the Add/Remove Snap-In dialog box, click Add.

Step 5 In the Add Standalone Snap-In dialog box, select the Performance Logs and Alerts control, and then 
click Add.

Step 6 In the Add Standalone Snap-In dialog box, select ActiveX Control, and then click Add.

Step 7 In the Insert ActiveX Control wizard, click Next.

Step 8 In the Control Categories list, select All Categories.

Step 9 In the Control Type list, select System Monitor Control.

Step 10 Select a name for the control, or accept the default name, then click Finish.

Step 11 In the Add Standalone Snap-In dialog box, click Close.

Step 12 Click OK.
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Step 13 Save the console you just created to an MSC file for later use.

To Embed Performance Monitoring Capability in a Document

Step 1 Open an OLE-capable document (for example, a Microsoft Word or Microsoft PowerPoint document.)

Step 2 On the Application menu, click Insert > Object.

Step 3 In the Insert Object dialog box, select System Monitor Control, and then click OK.

Step 4 Resize and configure the embedded control as necessary.

Performance Monitor Configuration for a Cisco Unity Server
Configuring the Microsoft Performance Monitor for use with Cisco Unity involves adding the applicable 
performance counters to a counter log. For a list of counters that need to be collected to begin the 
performance monitoring process, see Table 6-1. Additional counters may be necessary to refine the 
specific goals of a particular performance investigation, but the counters listed in Table 6-1 are a good 
start.

To Manually Configure the Performance Monitor for Real-time Performance Monitoring of a Cisco Unity Server

Step 1 On the Windows Start menu, click Programs > Administrative Tools > Performance.

Step 2 In the tree view, click System Monitor.

Step 3 In the control view in the right panel, right-click the applicable control.

Step 4 On the popup menu, click Properties.

Step 5 On the General tab of the System Monitor Properties dialog box, verify that the Update Automatically 
field is set to 5 Seconds or longer.

Step 6 On the Data tab of the System Monitor Properties dialog box, add the counters specified in Table 6-1, or 
any counters that are required for your test.

To Manually Configure the Performance Monitor for Data Collection (Performance Monitoring Log)

Step 1 On the Windows Start menu, click Programs > Administrative Tools > Performance.

Step 2 Expand the Performance Logs and Alerts control, and click Counter Logs.

Step 3 Right-click Counter Logs.

Step 4 On the popup menu, click New Log Settings.

Step 5 Enter a name for the new log settings, and then click OK.

Step 6 On the General tab of the dialog box, add the counters specified in Table 6-1, or any counters that are 
required for your test.

Step 7 Set the Data Sample Interval to 5 Minutes.

Step 8 On the Log Files tab of the dialog box, change the Log file type to Text File – CSV.
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Note We recommend that you use CSV file format, because CSV files are portable to external data 
manipulation and spreadsheet applications such as Perl scripting and Microsoft Excel.

Step 9 Set the maximum CSV file size to 10000K.

Step 10 Select the option to start a new log file when the maximum file size is reached.

Step 11 Set additional parameters as needed.

Performance Monitor Configuration for an Off-Box Cisco Unity Message Store 
Server

Usually, when you are monitoring an off-box Cisco Unity message store server, no local Cisco Unity 
processes need to be monitored. Instead, only the operating system and the message store resources need 
to be monitored.

The main process that needs to be monitored is the Information Store (Store.exe) that homes all of the 
databases on the Cisco Unity server. Usage of Store.exe is directly proportional to the number of users 
on the Cisco Unity system, the size of each database, and the number of databases and storage groups.

To Manually Configure the Performance Monitor for Real-Time Performance Monitoring of an Off-Box Message 
Store Server

Step 1 On the Windows Start menu, click Programs > Administrative Tools > Performance.

Step 2 In the tree view, click System Monitor.

Step 3 In the control view in the right panel, right-click the applicable control.

Step 4 On the popup menu, click Properties.

Step 5 On the General tab of the System Monitor Properties dialog box, verify that the Update Automatically 
field is set to a value between 5 Seconds and 10 Seconds.

Step 6 On the Data tab of the System Monitor Properties dialog box, add the counters specified in Table 6-1.

To Manually Configure the Performance Monitor for Data Collection Performance Monitoring

Step 1 On the Windows Start menu, click Programs > Administrative Tools > Performance.

Step 2 Expand the Performance Logs and Alerts control, and click Counter Logs.

Step 3 Right-click Counter Logs.

Step 4 On the popup menu, click New Log Settings.

Step 5 Enter a name for the new log settings, then click OK.

Step 6 On the General tab of the dialog box, add the counters specified in Table 6-1.

Step 7 Set the Data Sample Interval to 5 Minutes.

Step 8 On the Log Files tab of the dialog box, change the Log file type to Text File – CSV.
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Step 9 Set additional parameters as needed.

Administrative Monitoring Guidelines for Cisco Unity 
Performance

One of the key elements of a healthy and scalable messaging system is the active monitoring of the 
system by the administration ultimately responsible for its success. A good method to achieve this is to 
implement a performance maintenance policy that is supported throughout the deployment of each 
server in use by Cisco Unity. It is also important to document all necessary performance activities for 
purposes of scalability planning, capacity audits, and survivability of procedures through personnel 
changes.

We recommend creating a thorough plan that includes the following tasks:

1. Develop core measurements for indications of system health.

2. Define tools and methods to be used to monitor performance, and document usage of the tools.

You may decide to use a single application, such as CUPID or the Performance Monitor, to monitor 
messaging system performance, or you may choose to incorporate the monitoring of Cisco Unity 
and the messaging system into an existing administrative monitoring infrastructure. Third party 
monitoring solutions (for example, that use SNMP or WMI) are also available to monitor 
Cisco Unity and other Cisco products in a large enterprise environment.

3. Define a monitoring window.

This includes specifying monitoring timeframes, and deciding when collected logs will be cycled 
and reviewed. For example, a small company may not have personnel to monitor the messaging 
system on weekends and every day of the week. Therefore, this company could decide to create a 
snapshot of performance on Monday mornings, at the time of their busiest call volume.

4. Define a baseline.

A baseline for performance maintenance is crucial for the detection of deviations from normal 
business operations. Normal business operations should be defined as the average measurements 
from a typical business day. Depending on the business solution being monitored, the measurements 
could be gathered for an 8-hour core workday, for all daylight hours, for a 24-hour schedule, or for 
specific shift hours.

5. Periodically review and refine the collected information.

6. Set useful performance alerts and notifications.

7. Establish a problem resolution policy.

8. Establish a data warehousing policy.

Determine which data needs to be archived. Additionally, consider the storage location and archival 
time limit for the information.
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Performance Testing
A performance test can be useful in evaluating whether situations are appropriately handled by the 
Cisco Unity server or the Cisco Unity message store. For example, you may want to evaluate the 
performance of the Cisco Unity server during failover operations, under a significant load from 
web-based clients, or when extremely large numbers of users initially enroll.

Caution Do not run performance tests during an upgrade or while making changes to phone system integration 
settings. The Cisco Unity integration performance counters may not be available after an upgrade or after 
a change to the phone system integration, if the upgrade or integration change was made while 
performance monitoring services (CUPID or PerfMon) were running. See the “Troubleshooting 
Performance Counters” section on page 6-23 if you experience this problem.

Performance Testing Process
The performance testing process is similar to the scientific method of analysis in that the repeatability 
of findings is important to an understanding of a problem. In most cases, the performance testing process 
is cyclical. Every measurement session has the potential to spawn new questions or avenues of approach 
to the initial question. The cycle may have to be repeated numerous times before the operation under test 
is fully understood.
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We recommend the performance testing process shown in Figure 6-1.

Figure 6-1 Recommended Performance Testing Process

Preparing to Conduct the Test
The following “Task List: Preparing for Performance Testing” details the high-level tasks you need to 
do in preparation for performance testing. Also see the following procedures:

 • To Configure Diagnostic Tracing in the Cisco Unity Diagnostics Tool, page 6-11

 • To Start the Performance Monitoring Tool, page 6-11

 • To Start a Performance Monitor Counter Log, page 6-12

Task List: Preparing for Performance Testing

1. Determine the test criteria.

Due to the complex architecture of Cisco Unity, it is always a good idea to narrow the focus of the 
test, if possible. Performance dependencies between system components can quickly make an 
investigation very complex.
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2. Determine the role of user feedback in the test criteria.

For some deployments, this will be the primary concern for any performance consideration. For 
example, Maximum expected delays or system performance thresholds can be established with user 
input.

3. Determine the purpose of the performance test.

For example, you may want to monitor Cisco Unity performance to investigate a slow interactive 
response on an existing deployment, or to validate and gather baseline measurements of an existing 
message store infrastructure in preparation for a Cisco Unity installation.

4. Determine whether the entire system will be monitored or just a particular feature or area.

If a single feature is to be monitored, it may be possible to reduce the amount of monitoring 
necessary, while system level monitoring may require a broad range of performance data points. Is 
a particular area suspected as a bottleneck? If there has been a change to the Cisco Unity system, 
such as the addition of new hardware or software, and the change seems to have affected 
performance, the specific area should be monitored. Keep in mind that understanding the system 
performance as a whole has value, but if the purpose it to identify the cause of a particular 
bottleneck, narrowing the scope of the investigation is critical.

5. Specify the window of time to be measured and record that information independently of the 
performance logs.

Specifying a preset amount of time for measurement helps to frame the problem under investigation. 
For example, if users report slow access times when logging into Cisco Unity on Monday mornings, 
but not Tuesday mornings, plan for a sample taken from midnight on Sunday until the following 
Tuesday at midnight. With this information, data from Monday can be compared to the data from 
Tuesday, within the same set of results. Also, by recording start, stop, and duration sample times 
independently of the Performance Logs, issues of incorrect, unsynchronized, or remote system times 
can be avoided.

6. Select an appropriate level of diagnostic tracing.

Because performance tests should be conducted against the target system as that system is normally 
operated or configured, we recommend that Cisco Unity diagnostic traces be disabled for most 
performance testing, unless you are instructed otherwise by Cisco TAC.

To Configure Diagnostic Tracing in the Cisco Unity Diagnostics Tool

As a best practice, all diagnostic traces should be disabled except those that are directly related to the 
performance investigation, or as advised by Cisco TAC.

Step 1 On the Windows Start menu, click Programs > Cisco Unity > Cisco Unity Diagnostic Tool.

Step 2 Select the macro or micro traces appropriate for the system-specific performance investigation, or as 
specified by Cisco TAC.

If a performance problem is suspected as the cause of a port lockup, we recommend you select the 
System Locks macro trace.

Cisco TAC may request that additional tools, diagnostics, and procedures be executed on the target 
system, any of which may have an associated performance impact.

To Start the Performance Monitoring Tool

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.
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Step 2 In the left pane, under Diagnostic Tools, double-click CUPID.

To Start a Performance Monitor Counter Log

Step 1 Open the Microsoft Performance Monitor.

Step 2 Right-click the Counter Log that you prepared for the test in the “Configuring Microsoft Performance 
Monitor” section on page 6-5.

Step 3 On the popup menu, click Start.

Conducting the Test
Depending on the conditions that are being reproduced for the performance test, conducting the test can 
involve a variety of activities varying in duration. The goal can be as specific as understanding the 
memory utilization of a single application process, or as broad as gaining an understanding of overall 
system performance.

When the performance test is done, we recommend that you stop the collection of performance data, to 
reduce any operational overhead and prevent unneeded data from being entered into the performance log. 
Do the following “To Stop the Test” procedure.

Note If you are using the Performance Monitor, save the created or standard console settings so that the test 
can be repeated if necessary.

To Stop the Test

Step 1 On the Windows Start menu, open the CUPID control application, and click File > Stop Service.

Step 2 Right-click the applicable Performance Monitor Counter Log (or logs), and click Stop on the popup 
menu.

Measuring Performance and Collecting the Recorded Data
Locate the data file created during the monitored session. You will analyze the collected data by using 
the Performance Monitor or a suitable spreadsheet application, such as Microsoft Excel. CUPID logs 
can be opened in both Microsoft Performance Monitor and Microsoft Excel.

To Open a Captured Performance Log File in Performance Monitor

Step 1 On the Windows Start menu, click Programs > Administrative Tools > Performance.

Step 2 In the tree view, click System Monitor.

Step 3 In the control view in the right panel, right-click the applicable control.

Step 4 On the popup menu, click Properties.
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Step 5 On the Source tab of the System Monitor Properties dialog box, click Log File.

Step 6 Browse to the log file to be analyzed.

The default location for Performance Monitor logs is C:\PerfLogs.

Step 7 On the Data tab of the System Monitor Properties dialog box, add the counters that are under 
investigation. Note that only the counters that were recorded in the log will be available for selection.

To Open a Captured Performance Log File in Microsoft Excel

Step 1 Open Microsoft Excel.

Step 2 On the Application menu, click File > Open.

Step 3 Browse to the CSV file generated from the performance test.

The first row in the file represents the available counters that were tracked by the Performance Monitor 
on the target system and the first column represents the time of the sample. Each row entry constitutes 
a sample taken on the system and this number will vary depending on the sampling interval.

Collecting information about the system under test is just as important as gathering the performance data 
from the system. In most cases, it is necessary to run the Gather Cisco Unity System Information (GUSI) 
tool, available in Tools Depot, and to run Microsoft WinMSD on both the Cisco Unity Server and the 
Cisco Unity message store.

Note that both of these tools can impact system performance. Schedule the collection of system test 
information during a maintenance window, if possible.

To Run the Gather Cisco Unity System Information (GUSI) Tool

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Reporting Tools, double-click Gather Unity System Info.

Step 3 Run the Gather Cisco Unity System Information utility.

Step 4 Select a location for the .CAB file that contains the Cisco Unity system information.

Step 5 Click Write to File, and save the system information to the specified location.

To Run WinMSD

Step 1 On the Windows Start Menu, click Run.

Step 2 In the Run dialog box, enter winmsd.

Step 3 Right-click the System Information root, and select Save as Text File.

Step 4 Save the generated text file with the collected performance data for comparison and reference.
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Note The information collection process may take a significant amount of time to complete, and the 
program may appear to stall or hang during this process.

To Collect Event Logs

Step 1 On the Windows Start Menu, click Run.

Step 2 In the Run dialog box, enter eventvwr.

Step 3 Right-click the Application Event Log, and select Save Log File As.

Step 4 Save the log file for future reference.

Step 5 Right-click the System Event Log, and select Save Log File As.

Step 6 Save the log file for future reference.

Analyzing Performance Test Results
Analysis of collected performance test results is an extremely important part of understanding the overall 
performance of Cisco Unity. The following guidelines allow you to validate, understand, and evaluate 
the information generated from a performance test.

To validate collected data, open the captured log file in the Performance Monitor or a spreadsheet 
application and verify that data has actually been recorded. The columns within the open document will 
contain data in the sequence in which the sample was taken (for most entries.) Columns that are blank 
represent objects or counters that were non-existent on the target system during the collected sample 
time.

External, user-discernible indicators of poor Cisco Unity system performance include:

 • Unexpected delays when dialing into Cisco Unity

 • Unexpected delays when accessing or deleting voice messages

 • Long delays between voice prompts

 • Choppy voice playback

 • Sluggish Cisco Unity Assistant and/or Cisco Unity Administrator response

 • Sluggish window refresh or input device response when logged on locally

Note that some of these indicators are subjective, especially those focusing on the amounts of silence or 
delay experienced by a user during the Cisco Unity conversation.

There are also internal, or administratively measurable, indicators of poor Cisco Unity system 
performance:

 • Excessive processor usage

 • High memory paging

 • Heavy disk usage

 • Inconsistent memory usage or memory leaks
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 • High network bandwidth consumption or traffic queueing

Key objects for the initial assessment of a target system are the Memory, Process, Processor, Telephony, 
and Cisco Unity performance objects. These objects contain many of the core data points that are helpful 
in determining system activity. For example, when using the Telephony object, the Current Incoming 
Calls and Current Outgoing Calls counters describe the call activity into and out of the Cisco Unity 
server, and thus are a good indication of average voice session traffic.

To obtain information such as call duration, call forwarding, and phone system transfers into 
Cisco Unity, use the Port Usage Analyzer tool (available in Tools Depot), as well as external sources of 
information such as phone system reports or call detail records. This data can be used in conjunction 
with the data collected from the Cisco Unity system to form a complete picture of phone system activity 
during the monitored period.

At a minimum, the following phone system information should be collected:

 • Average Call Duration or Average Hold Time

 • Average Length of a recorded message to a Cisco Unity subscriber

 • Statistics showing the distribution of call types coming into the Cisco Unity server (for example, 
Direct Call, Call Forward–Ring No Answer, Call Forward–Busy)

Session traffic into the system from web clients should also be collected. This information can be 
obtained through the use of the Web Services object, which allows you to track Cisco Unity Assistant 
and Cisco Unity Administrator logons and connections.

Developing a Corrective Action Plan
Using your analysis of the collected data, determine which areas you can focus on for performance 
improvements. Cisco Unity best practices can also be a source for a corrective action plan.

Administrative Best Practices for Cisco Unity Performance

Following these best practices will have a positive affect on Cisco Unity performance.

 • Do not run extraneous servers or applications on the Cisco Unity server.

 • Set processes for background processing.

 • Do not implement real-time virus scanning on the message store. Conduct scanning at the 
connection points to the messaging environment.

 • Unified Messaging subscribers should not have Inboxes that exceed 100 MB or 1,000 messages. 
Because the processing of messages happens in real-time when the users log on to check their 
messages, mailbox size directly affects Cisco Unity conversation performance. Keep in mind that 
because certain types of message can be very large, subscribers who have relatively few messages 
stored in their mailboxes may still find that their mailboxes exceed the storage limits. 

Modifying the System to Implement the Corrective Action Plan
Make modifications as necessary to implement the performance improvement decisions that you have 
made, based on analysis of collected performance data.
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Resolving Identified Issues
Run the performance tests again to determine whether the corrective action plan that you implemented 
improved performance, resolved identified performance issues, and did not introduce any new 
performance issues.

Completing the Test Cycle
Document your findings, the corrective action you have taken, and the results of the repeat performance 
tests.

Performance Counters
To monitor physical disk performance information, it is necessary to enable the disk performance 
counters on the server. With Windows 2000, the physical disk performance counters are enabled by 
default. In Cisco Unity version 4.0(3) and later, the performance counters for measuring Cisco Unity 
data points are also enabled by default.

Required System Performance Counters
The counters in Table 6-1 should be collected from any Cisco Unity server or Cisco Unity message store 
performance monitoring session

Table 6-1 Required System Performance Counters 

Required System Performance Counters

\Cache\Data Map Hits%

\Memory\Available Bytes

\Memory\Commit Limit

\Memory\Committed Bytes

\Memory\Free System Page Table Entries

\Memory\Page Faults/sec

\Memory\Pages Input/sec

\Memory\Pages Output/sec

\Memory\Pages/sec

\Network Interface(*)\Bytes Received/sec

\Network Interface(*)\Bytes Sent/sec

\Paging File(_Total)\% Usage Peak

\PhysicalDisk(_Total)\% Disk Time

\PhysicalDisk(_Total)\Avg. Disk Bytes/Transfer

\PhysicalDisk(_Total)\Avg. Disk Queue Length

\PhysicalDisk(_Total)\Avg. Disk sec/Read
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General System Performance Counters
Table 6-2 shows counters that are applicable to both the Cisco Unity server and the Cisco Unity message 
store, including their recommended safe values.

\PhysicalDisk(_Total)\Avg. Disk sec/Write

\PhysicalDisk(_Total)\Current Disk Queue Length

\PhysicalDisk(_Total)\Disk Reads/sec

\PhysicalDisk(_Total)\Disk Writes/sec

\System\Processes

\System\Processor Queue Length

\System\System Calls/sec

\System\Threads

\Processor(_Total)\% Interrupt Time

\Processor(_Total)\% Processor Time

\Processor(_Total)\Interrupts/sec

\Processor(_Total)\% Privileged Time

\Processor(_Total)\% User Time

\PhysicalDisk(_Total)\% Idle Time

Table 6-1 Required System Performance Counters (continued)

Required System Performance Counters

Table 6-2 General System Performance Counters 

Object Counter Description Recommended Value

Memory Available 
Bytes

Available Bytes is the amount of physical memory 
available to processes that are running on the 
computer. It is calculated by summing space on 
the Zeroed, Free, and Standby memory lists:

 • Zeroed memory is pages of memory filled 
with zeros to prevent later processes from 
seeing data used by a previous process.

 • Free memory is ready for use.

 • Standby memory is memory removed from a 
process working set (its physical memory) on 
route to disk, but is still available to be 
recalled. Standby memory is the last observed 
value only; it is not an average.

The recommended value for Available Bytes 
is a reflection of the amount of available 
memory and the type of activities required of 
the system. For Unified Messaging, a system 
that consistently has approximately 
one-eighth of its total physical memory 
available would be a candidate for further 
memory troubleshooting, and potentially a 
memory upgrade. If the available bytes are as 
low as 4 MB, there is a memory issue and 
performance may begin to suffer. If the 
available bytes are as low as 1 MB, server 
performance will be degraded.
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Memory Free System 
Page Table 
Entries

Free System Page Table Entries (PTE) is the 
number of page table entries that are used to map 
each virtual address into a corresponding physical 
address and are not being used by the system. This 
counter displays the last observed value only. It is 
not an average. The PTE pool size is automatically 
determined at system startup. As the PTE pool 
decreases, other parts of the system will degrade, 
resulting in threads not being created, system 
stalls, and other system failures. 

To maintain a stable system, the amount of 
free PTEs on the Cisco Unity server should be 
greater than or equal to 15,000.

Memory Page 
Faults/sec

Page Faults/sec is the overall rate at which faulted 
pages are handled by the processor. It is measured 
in numbers of pages faulted per second. A page 
fault occurs when a process requires code or data 
that is not in the working set (space in physical 
memory). This counter includes both hard faults 
(those that require disk access) and soft faults 
(where the faulted page is found elsewhere in 
physical memory). This counter displays the 
difference between the values observed in the last 
two samples, divided by the duration of the sample 
interval.

The identification of a memory bottleneck 
can be derived by considering this value in 
relation to the number of Pages Input/sec or 
Pages Output/sec. Soft faults do not 
necessarily indicate a memory shortage 
problem, just that the system is highly active. 
Hard faults, on the other hand, indicate that 
there is not enough physical memory to attend 
to the process tasks that need to be 
accomplished, and that memory pages are 
increasingly being moved to and from the 
physical disk for persistence. Invariably, a 
memory issue of this type will show a 
corresponding increase in activity of the 
physical disks that home the paging files. To 
calculate Hard Page Faults as a percentage of 
faults occurring on the system, divide the 
Page Inputs/sec by the Page Faults/sec.

Memory Pages 
Input/sec

Pages Input/sec is the number of pages read from 
disk to resolve hard page faults. (Hard page faults 
occur when a process requires code or data that is 
not in its working set or elsewhere in physical 
memory, and must be retrieved from disk). This 
counter was designed as a primary indicator of the 
kinds of faults that cause systemwide delays. It 
includes pages retrieved to satisfy faults in the file 
system cache (usually requested by applications) 
and in non-cached mapped memory files. This 
counter counts numbers of pages, and can be 
compared to other counts of pages, such as Page 
Faults/sec, without conversion. This counter 
displays the difference between the values 
observed in the last two samples, divided by the 
duration of the sample interval.

Because the value of this counter indicates the 
count of pages that are needed from the 
physical disk to satisfy virtual memory 
requests for pages that are not in physical 
memory (hard page faults), the lower this 
value is, the better.

Table 6-2 General System Performance Counters (continued)

Object Counter Description Recommended Value
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Memory Pages 
Output/sec

Pages Output/sec is the number of pages written to 
disk to free up space in physical memory. Pages 
are written to disk only if they are changed in 
physical memory, so they are likely to hold data, 
not code. Windows NT writes more pages back to 
disk to free up space when physical memory is in 
short supply. This counter counts numbers of 
pages, and can be compared to other counts of 
pages, without conversion. This counter displays 
the difference between the values observed in the 
last two samples, divided by the duration of the 
sample interval.

This counter is useful for tracking memory 
paging activity that might indicate movement 
of pages out to physical disk. A high rate of 
pages output might indicate a memory 
shortage.

Memory Pages/sec The value of this counter indicates the physical 
disk paging activity to satisfy virtual memory 
requests for pages that are not in physical memory.

This counter is a primary indicator of the 
kinds of faults that cause systemwide delays. 
The lower this value is, the better. It should 
average less than 10 pages per second.

Network 
Interface

Bytes 
Received/ 
sec

Bytes Received/sec is the rate at which bytes are 
received on the interface, including framing 
characters.

This value should not exceed 20 percent of the 
available bandwidth on the network interface.

Network 
Interface

Bytes 
Sent/sec

Bytes Sent/sec is the rate at which bytes are sent 
on the interface, including framing characters.

This value should not exceed 50 percent of the 
available bandwidth on the network interface.

Processor % Processor 
Time

% Processor Time is the percentage of time that 
the processor is executing a non-Idle thread. This 
counter was designed as a primary indicator of 
processor activity. It is calculated by measuring 
the time that the processor spends executing the 
thread of the Idle process in each sample interval, 
and subtracting that value from 100 percent. (Each 
processor has an Idle thread that consumes cycles 
when no other threads are ready to run). It can be 
viewed as the percentage of the sample interval 
spent doing useful work. This counter displays the 
average percentage of busy time observed during 
the sample interval. It is calculated by monitoring 
the time the service was inactive, and then 
subtracting that value from 100 percent.

High activity per processor does not 
immediately indicate a processor bottleneck. 
If the value consistently stays at or near 100 
percent, then there is likely a processor 
bottleneck. When the message store is 
off-box, this value is considered within 
operating norms if it is below 85 percent.

System Processor 
Queue 
Length

Processor Queue Length is the number of threads 
in the processor queue. There is a single queue for 
processor time even on computers with multiple 
processors. Unlike the disk counters, this counter 
counts ready threads only, not threads that are 
running. This counter displays the last observed 
value only; it is not an average.

Depending on the number of processors on a 
system, this value is generally considered a 
bottleneck if the value exceeds two times the 
number of processors. This value should be 
viewed in conjunction with % Processor Time 
to get a good view of the processor activity on 
the system.

Table 6-2 General System Performance Counters (continued)

Object Counter Description Recommended Value
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Table 6-3 shows important Cisco Unity server counters and their recommended safe values.

Table 6-3 Cisco Unity Server Performance Counters 

Object Counter Description Recommended Value

Cisco Unity 
Sessions 
(Voice)

Delay – 
Opening 
Greeting

Delay Opening Greeting is the delay (in tenths 
of a second) experienced by a caller before any 
audio is heard. It measures the time from 
receipt of the call by the system to the 
beginning of the audio stream to the caller.

This is a subjective value, but if this value is 
greater than 40 (4 seconds), further 
investigation should be conducted to 
determine the cause of the delay.

Cisco Unity 
Sessions 
(Voice)

Delay – Get 
Header

Delay Get Header is the delay (in tenths of a 
second) experienced by a caller while 
Cisco Unity gathers message header 
information.

This is a subjective value, but if this value is 
greater than 40 (4 seconds), further 
investigation should be conducted to 
determine the cause of the delay.

Cisco Unity 
Sessions 
(Voice)

Delay – 
Subscriber 
Delete 
Message

Delay Subscriber Delete Message is the delay 
(in tenths of a second) experienced by a 
Cisco Unity subscriber when attempting to 
delete a message. It measures the time from the 
final delete message prompt to confirmation of 
the deletion.

This is a subjective value, but if this value is 
greater than 40 (4 seconds), further 
investigation should be conducted to 
determine the cause of the delay.

Cisco Unity 
Sessions 
(Voice)

Delay – 
Subscriber 
Logon

Delay Subscriber Logon is the delay (in tenths 
of a second) experienced by a Cisco Unity 
subscriber during logon. It measures the time 
from the final keypress of the subscriber 
password to the first menu prompt.

This is a subjective value, but if this value is 
greater than 40 (4 seconds), further 
investigation should be conducted to 
determine the cause of the delay.

Cisco Unity 
Sessions 
(Voice)

Delay – 
Subscriber 
Message 
Access

Delay Subscriber Message Access is the delay 
(in tenths of a second) experienced by a 
Cisco Unity subscriber when attempting to 
access a message. It measures the time from the 
subscriber key press to listen to a message to 
the actual playback of the message.

This is a subjective value, but if this value is 
greater than 40 (4 seconds), further 
investigation should be conducted to 
determine the cause of the delay.

Cisco Unity 
Sessions 
(Voice)

Delay – 
Subscriber 
Record 
Message

Delay Subscriber Record Message is the delay 
(in tenths of a second) experienced by a 
Cisco Unity subscriber when attempting to 
record a message. It measures the time from the 
final record message prompt to the record beep.

This is a subjective value, but if this value is 
greater than 40 (4 seconds), further 
investigation should be conducted to 
determine the cause of the delay.
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Process\ 
[Cisco Unity 
Process]

Private 
Bytes

Private Bytes is the current number of bytes that 
are allocated by each Cisco Unity process and 
cannot be shared with other processes.

The value for this counter can vary 
dramatically, but the important thing to note 
is whether private bytes are continually being 
used and not released (a situation that is 
commonly known as a memory leak).

For example, memory usage over the course 
of the first day that a Cisco Unity system is 
in use may initially suggest that there is a 
memory leak, because components are 
loaded when needed. However, memory 
usage should then level off to be consistent 
over time.

Process\ 
AvCsMgr

% Processor 
Time

The Manager (AvCsMgr) is the core voice 
processing system that manages all other 
Cisco Unity components, provides status on the 
state of the components, and exposes interfaces 
to other internal and external components.

The % Processor Time value should not 
exceed an average of 60 percent. If it does, 
activity may be greater than the system is 
capable of handling.

Process\ 
AvCsGateway

% Processor 
Time

The Gateway (AvCsGateway) process provides 
a secure interface to the Manager that allows 
external processes to query the state of the 
Manager, start or stop the Manager, or request 
internal interfaces to Manager components (if 
allowed).

The % Processor Time value should not 
exceed an average of 25 percent. If it does, 
activity may be greater than the system is 
capable of handling.

Process\ 
AvCsMgr

Handle 
Count

The AvCsMgr Handle Count is the total number 
of handles currently in use by the Manager 
process. This number is the sum of the handles 
currently open by each thread in this process.

After an initial build up, the handles in use 
should remain constant. The maximum value 
should not exceed 25,000 handles.

Process\ 
AvCsMgr

Virtual 
Bytes

Virtual Bytes is the current size in bytes of the 
virtual address space in use by the Manager 
process. Virtual space is finite, and therefore if 
too much is used, the process can limit its 
ability to load libraries.

After an initial build up, virtual bytes should 
remain fairly constant. On Microsoft 
Windows 2000 Server systems, the 
maximum value should not exceed 1.65 GB. 
On Microsoft Windows 2000 Advanced 
Server systems using the /3GB switch, the 
maximum value should not exceed 2.4 GB.

Process\ 
inetinfo

% Processor 
Time

The Inetinfo process provides the interface to 
the Cisco Unity Administrator and the 
Cisco Personal Communications Assistant 
applications.

The % Processor Time value should not 
exceed an average of 25 percent. If it does, 
activity may be greater than the system is 
capable of handling.

Table 6-3 Cisco Unity Server Performance Counters (continued)

Object Counter Description Recommended Value
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Table 6-4 shows important Cisco Unity message store counters and their recommended safe values.

Telephony Current 
Incoming 
Calls

The Current Incoming Calls counter measures 
the call activity coming into the Cisco Unity 
server. Along with Current Outgoing Calls, it is 
a good indication of average voice session 
traffic.

The recommended value for Incoming Calls 
is a reflection of the number of available 
ports. Systems that consistently have all 
incoming ports busy may require additional 
ports.

Telephony Current 
Outgoing 
Calls

The Current Outgoing calls counter is the call 
activity going out from the Cisco Unity server. 
Along with Current Incoming Calls, it is a good 
indication of average voice session traffic.

The recommended value for Incoming Calls 
is a reflection of the number of available 
ports. Systems that consistently have all 
outgoing ports busy may require additional 
ports.

Table 6-3 Cisco Unity Server Performance Counters (continued)

Object Counter Description Recommended Value

Table 6-4 Cisco Unity Message Store Performance Counters 

Object Counter Description Recommended Value

Database Log Record 
Stalls/sec

Log Record Stalls/sec is the number 
of log records that cannot be added 
to the log buffers per second because 
they are full.

This value should remain as close to 0 (zero) 
as possible. Generally, an average recorded 
value greater than 2 during normal 
operations indicates a bottleneck.

Database Table Opens/sec Table Opens/sec is the number of 
database tables opened per second.

This counter is a good indicator of overall 
system usage.

Physical Disk % Disk Time % Disk Time is the percentage of 
elapsed time that the selected disk 
drive is busy servicing read or write 
requests.

If this value exceeds 60 percent (on average) 
for sustained periods of time, an 
investigation into the performance of the 
system may be needed.

Physical Disk Avg. Disk sec/ 
Read

Avg. Disk sec/Read is the average 
time in seconds to read data from the 
disk.

Any average value exceeding .02 indicates a 
physical disk bottleneck. Because this is a 
direct indicator of the length of time needed 
to read information from the disk, the 
maximum value should be noted. Spikes in 
this value would indicate delays reading 
information from the disk.

Physical Disk Avg. Disk sec/ 
Write

Avg. Disk sec/Write is the average 
time in seconds to write data to the 
disk.

Any average value exceeding .02 indicates a 
physical disk bottleneck. Because this is a 
direct indicator of the length of time needed 
to write information to the disk, the 
maximum value should be noted. Spikes in 
this value indicate delays writing 
information to the disk.
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Troubleshooting Performance Counters
The Cisco Unity integration performance counters may not be available after an upgrade or after a 
change to the phone system integration, if the upgrade or integration change was made while 
performance monitoring services (CUPID or PerfMon) were running.

To Re-Enable Performance Counters After an Upgrade or After a Change to the Phone System Integration

Step 1 On the Cisco Unity server, click Start > Programs > Administrative Tools > Services.

Step 2 Stop the Cisco Unity Performance Information and Diagnostics service, if it is installed on the 
Cisco Unity server.

Step 3 Set the Cisco Unity Performance Information and Diagnostics service Startup type to Manual.

Step 4 Click Start > Programs > Administrative Tools > Performance.

Step 5 Stop any counters or trace logs that are currently running.

Step 6 Start Regedit.

Caution Changing the wrong registry key or entering an incorrect value can cause the server to 
malfunction. Before you edit the registry, confirm that you know how to restore it if a problem 
occurs. (Refer to the “Restoring” topics in Registry Editor Help.) Note that when Cisco Unity 
failover is configured, registry changes on one Cisco Unity server must be made manually on 
the other Cisco Unity server, because registry changes are not replicated. If you have any 
questions about changing registry key settings, contact Cisco TAC. 

Step 7 If you do not have a current backup of the registry, click Registry > Export Registry File, and save the 
registry settings to a file.

Step 8 Delete the Performance Counter Variables registry key, located at

HKLM\Software\Active Voice\AvLogMgr\1.0\PerformanceCounterVariables

Physical Disk Current Disk 
Queue Length

Current Disk Queue Length is the 
number of requests outstanding on 
the disk at the time the performance 
data is collected. Multi-spindle disk 
devices can have multiple requests 
active at one time, while other 
concurrent requests are awaiting 
service. This counter might reflect a 
transitory high or low queue length, 
but if there is a sustained load on the 
disk drive, it is likely that this value 
will be consistently high. Requests 
experience delays proportional to 
the length of this queue minus the 
number of spindles on the disks.

This value should not average more than 
2 to 4. Because this is a value measured at 
the operating system level, delays in the 
queue at the driver level are likely to affect 
performance.

Table 6-4 Cisco Unity Message Store Performance Counters (continued)

Object Counter Description Recommended Value
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Step 9 Restart the Cisco Unity server.

After Cisco Unity has restarted, the Cisco Unity integration performance counters will be available, and 
the registry key deleted in Step 8 will be automatically re-created.
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Installing Recommended Service Packs and 
Updates

Recommended Service Packs and Updates Overview
Microsoft provides monthly updates for Windows Server 2003, Windows 2000 Server, SQL Server 2000, 
MSDE 2000, Internet Explorer, and IIS. These updates (known by a variety of names, including security 
rollup patches, security updates, critical updates, patches, and hot fixes) are limited to changes that fix 
specific problems. They do not include general defect fixes or new functionality. All of these Microsoft 
updates are qualified by Cisco from the day that Microsoft releases them. We recommend that you 
evaluate Microsoft updates in accordance with your server-software-maintenance policy to determine 
when to update the Cisco Unity server or Cisco Unity Bridge server. If your company does not have a 
policy, we recommend that Microsoft updates be applied to the server as they are released. Cisco TAC 
provides support for a Cisco Unity system on which such updates have been installed.

Microsoft also occasionally releases service packs, which contain fixes generated since the general 
product release, including most fixes that were released as updates. Because the service pack scope is 
broad, each service pack must be thoroughly tested to ensure that changes do not adversely affect 
Cisco Unity or the Bridge. Cisco TAC does not support new service packs until they have been qualified 
for use with Cisco Unity or the Bridge.

Do not install a service pack that has not been qualified, or Cisco TAC will not help you resolve problems 
until you uninstall it.

Within 60 days of an applicable Microsoft service pack release, Cisco will announce whether the service 
pack can be applied to released Cisco Unity and Bridge versions. If so, the new service pack becomes 
the recommended service pack for Cisco Unity and the Bridge.

Updates and service packs can be applied to other non-Cisco Unity servers such as IBM Lotus Domino 
servers. Cisco does not require such updates and service packs to be applied to infrastructure servers and 
clients unless they are to resolve specifically identified problems that relate to the interactions between 
Cisco products and a customer infrastructure. When applying a mail server service pack, we recommend 
following Microsoft best practices of applying the service pack level to all mail servers within the 
organization. Client PCs and voice mail access devices (for example, PDAs), as well as mail servers, 
domain controllers, and global catalog servers, may all be considered part of the customer infrastructure.

Cisco will support—at most—two service packs of a given Microsoft component as recommended for 
major and minor releases of Cisco Unity and the Bridge. When a subsequent service pack is released, 
Cisco will drop support for the oldest service pack as being recommended in the next major or minor 
release of Cisco Unity or the Bridge. When a subsequent service pack is released, Cisco will drop 
support for the oldest service pack as being recommended in the next major or minor release of 
Cisco Unity.
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Downloading Recommended Service Packs and Updates
When a service pack is qualified as recommended for use with Cisco Unity or the Bridge, it is supported 
for all currently supported versions of Cisco Unity or the Bridge, unless a specific Cisco product version 
is noted as being required in order to support the recommended service pack.

For the most current information on the Microsoft service packs that have been qualified for use with 
Cisco Unity, refer to the Recommended and Supported Service Packs and Updates for Use with 
Cisco Unity and the Cisco Unity Bridge, available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/cmptblty/msupdate.htm.

Downloading Recommended Service Packs and Updates
The service packs that were recommended when the current version of Cisco Unity was released are on 
the Cisco Unity Service Pack CDs, and are available at 
http://www.cisco.com/cgi-bin/tablebuild.pl/unity-40. Any additional service packs that were qualified 
and recommended for use with Cisco Unity after the current version of Cisco Unity was released are 
available for download on the Microsoft website. If you download a new service pack from the Microsoft 
website, also download or print the installation instructions.

The updates that were recommended when the current version of Cisco Unity was released are on the 
Cisco Unity Post-Install CD. Any additional updates recommended for use with Cisco Unity are 
available for download at http://www.cisco.com/cgi-bin/tablebuild.pl/unity_msft_updates. Updates are 
available in English, French, German, and Japanese. Download the applicable language version for the 
software installed on the Cisco Unity server.

Installing Recommended Service Packs and Updates
Some Microsoft updates can only be installed after a prerequisite service pack has been installed. Install 
all of the latest service packs recommended for use with Cisco Unity, if any, before you install updates.

To Install the Latest Microsoft Service Packs Recommended for Use with Cisco Unity

Step 1 Follow the instructions that you printed or downloaded when you downloaded the service packs.

To Install the Latest Microsoft Updates Recommended for Use with Cisco Unity

Step 1 Browse to the location of the downloaded Microsoft updates.

Step 2 Browse to each directory, and install each update. To speed the installation, you may want to:

 • Install each update at a command prompt by using the /z option, so that you do not have to restart 
the computer after installing each update.

 • Install each update at a command prompt by using the /m option, so that the update installs without 
displaying any dialog boxes.

 • Create a batch file that installs all of the updates at once.

Step 3 Restart the Cisco Unity server.
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Accessing Cisco Unity Remotely
There are several methods that allow remote access to the Cisco Unity server so that you can do 
tasks—such as loading updates or patches, and transferring files—that otherwise would have to be done 
locally. Depending on your site, you can set up remote access to the Cisco Unity server as described in 
the following sections:

 • Using Windows Terminal Services, page 8-1

 • Using pcAnywhere, page 8-3

 • Using a Virtual Private Network, page 8-4

Using Windows Terminal Services
Windows Terminal Services (WTS) comes with Windows 2000, and should already be set up on the 
Cisco Unity server. In order to set up and use WTS on your remote computer, do the following 
procedures. (For details on setting up WTS on the Cisco Unity server, refer to the “Manual Installation 
Procedures for Software Installed by the Cisco Unity System Preparation Assistant During a New 
Installation” Appendix of the Cisco Unity Installation Guide. Refer to the installation guide for your 
Cisco Unity 4.0(5) configuration at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

To find additional information about WTS, refer to the Help available from either the Terminal Services 
server program on the Cisco Unity server, or from the Terminal Services Client program that you install 
on the remote computer. You can also refer to the Microsoft website.

Note that in order to use the paste function in the Medial Master when you use WTS to access either the 
Cisco Unity Administrator or Cisco Personal Communications Assistant on a Cisco Unity server using 
Windows 2000, the WAV file that you paste must be in G.711 format.

To Create the Windows Terminal Client Install Disks

To use WTS on a remote computer, you must first create a set of install disks by using the WTS host 
program on the Cisco Unity server. You will need two blank disks—labeled “Disk 1” and “Disk 2”—to 
do this procedure.

Step 1 On the Cisco Unity server, on the Windows Start menu, click Programs > Administrative Tools > 
Terminal Services Client Creator.
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Step 2 In the Create Installation Disk(s) dialog box, do the following sub-steps:

a. Click Terminal Services for 32-bit x86 Windows.

b. Check the Format Disk(s) check box to erase any existing data on the disks, and then click OK.

Step 3 Follow the on-screen instructions to create the two install disks.

Step 4 Close the Create Installation Disk(s) dialog box.

To Set Up the WTS Client on a Remote Computer

Step 1 On the remote computer, insert Disk 1 in the A drive, and run Setup.exe.

Step 2 Follow the on-screen instructions to complete the installation.

Step 3 On the Windows Start menu, click Programs > Terminal Services Client > Client Connection 
Manager.

Step 4 In the Client Connection Manager window, click File > New Connection.

Step 5 Follow the on-screen instructions to complete the Connection wizard.

To Start a Remote Session with WTS

When you connect to the Cisco Unity server from a remote computer by using WTS, your computer 
controls the server. The Cisco Unity server screen appears within a window on your remote computer 
and, in general, you can access any of the server files and applications. We recommend that the 
Cisco Unity server host only one WTS connection at a time. Note also that you can run a Notes or 
Domino Admin session either locally or by using a WTS session, but not both at the same time.

Step 1 On the remote computer, do one of the following:

 • In the Client Connection Manager window, double-click the new connection icon that was created 
in the “To Set Up the WTS Client on a Remote Computer” procedure.

 • On the Windows Start menu, click Programs > Terminal Services Client > <New connection 
icon>. If you changed the default location for the new connection icon, go to the location that you 
specified in the “To Set Up the WTS Client on a Remote Computer” procedure.

Step 2 Log on to the Cisco Unity Administrator with the applicable name and password.

To Do File Transfers

Step 1 On the remote computer, run \\<IP Address for Cisco Unity Server>\c$.

Step 2 Log on to the Cisco Unity Administrator with the applicable name and password.

Step 3 Transfer files by using either copy-and-paste or drag-and-drop Windows commands.
8-2
Cisco Unity 4.0(5) Maintenance Guide (With IBM Lotus Domino)

OL-7400-01



  

Chapter 8      Remote Access
Using pcAnywhere
To End a Remote Session with Windows Terminal Services

Step 1 On the remote computer, log off and exit the Cisco Unity Administrator.

Step 2 Close the Terminal Services Client <New Connection> window.

Step 3 When prompted, click OK to end the remote connection session.

Windows Terminal Services Limitations
WTS is supported for use on the Cisco Unity server, with the limitations shown in Table 8-1.

Using pcAnywhere
You can install pcAnywhere on the Cisco Unity server and on remote computer(s) that will be used to 
access the Cisco Unity server in your organization. Contact your reseller for the applicable number of 
licenses.

Use the following procedures to set up and use pcAnywhere on a remote computer. For more detailed 
procedures or information about the other pcAnywhere capabilities that may be useful to you, refer to 
the pcAnywhere documentation.

To Set Up pcAnywhere on a Remote Computer

Step 1 Insert the pcAnywhere compact disc in the remote computer.

Step 2 Follow the on-screen instructions to complete the installation.

Step 3 On the Windows Start menu, click Programs > Symantec pcAnywhere, or double-click the desktop 
shortcut provided.

Step 4 In the pcAnywhere Manager window, double-click the Add Remote icon.

Step 5 From the Connection Info tab, do one of the following:

 • If you are using a modem connection, check the applicable check box in the Device List to indicate 
the modem that is used by your remote computer. Then, click the Settings tab, and enter the phone 
number of the Cisco Unity server in the Use Dialing Properties and Phone Number fields.

Table 8-1 Windows Terminal Services Limitations with Cisco Unity 

Remote Functionality Cisco Unity 4.0(1) and Later

Install or upgrade Cisco Unity Not supported

Set the dB level of recorded names and greetings 
by using the Set Volume utility

Not supported

Convert recorded names and greetings to a 
different codec by using the Set Wav Format utility

Not supported

Using WTS in console mode, which is available 
through the /console command line parameter

Not supported
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 • If you are using a LAN connection, confirm that TCP/IP is selected. Then, click the Settings tab, 
and enter the IP address for the Cisco Unity server in the Network Host PC to Control or IP Address 
field.

Step 6 Enter or change other properties as needed on the remaining tabs.

Step 7 Click OK.

Step 8 Enter a name for the new Remote icon that you just created, and then press Enter.

To Start a Remote Session with pcAnywhere

When you connect to the Cisco Unity server from a remote computer by using pcAnywhere, your 
computer controls the server. The Cisco Unity server screen appears within a window on your remote 
computer and, in general, you can access any of the server files and applications. Before you start a 
remote session, confirm that pcAnywhere is running in host mode on the Cisco Unity server. If you plan 
to use a modem connection, confirm that there is no checkmark in the Launch With Windows check box 
on the Settings tab of the Host Properties dialog box.

Note that a Cisco Unity server can host only one pcAnywhere connection at a time.

Step 1 On the remote computer, double-click the desktop shortcut provided to start pcAnywhere.

Step 2 Double-click the new Remote icon that was created in the “To Set Up pcAnywhere on a Remote 
Computer” procedure.

Step 3 When it becomes available, click the listing for the Cisco Unity server that you want to access, and then 
click OK.

When a connection with the Cisco Unity server is established, the desktop of the Cisco Unity server 
appears, and the pcAnywhere online toolbar is displayed across the top of the screen.

Step 4 If desired, do the following sub-steps to improve your connection speed:

a. From the pcAnywhere online toolbar, click View/Modify Online Options.

b. In the Online Options dialog box, click 16 Colors from the Color Scale menu, and then click OK.

Step 5 Log on to the Cisco Unity Administrator with the applicable name and password.

To End a Remote Session with pcAnywhere

Step 1 On the remote computer, log off and exit the Cisco Unity Administrator.

Step 2 From the pcAnywhere online toolbar, click End Remote Control Session, and then click Yes.

Using a Virtual Private Network
A Virtual Private Network (VPN) is a private network that uses public phone lines (or in some cases a 
cable modem). Privacy is maintained through encryption and the use of secure protocols. When you use 
a VPN to access Cisco Unity through a firewall, you will be able to use Cisco Unity as if you were inside 
the network.
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VPN is required in the following circumstances:

 • You need access to the Cisco Unity Administrator website (http://<Cisco Unity server 
name>/web/sa) from a remote computer outside your network firewall.

 • You need to use the Media Master control bar to record voice names and greetings by using 
Distributed Component Object Model (DCOM) to connect your remote computer to the Cisco Unity 
server through a firewall. 

Note If you are not using VPN for remote access, refer to the Microsoft website for information on 
configuring DCOM through a firewall.

Discuss setting up a VPN with your LAN administrator.
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Overview: Reports
You can use Cisco Unity reports to gain information about subscribers and system activity. Some 
Cisco Unity reports provide information about subscribers and system activity over a period of time. 
Others offer a “snapshot” of a particular Cisco Unity entity as it stands at the time you run the report.

See the following sections in this chapter to learn more about using Cisco Unity reports:

 • About Report Data, page 9-2—This section provides information about how Cisco Unity gathers 
and stores report data, and which settings you can change to ensure that your reports contain the data 
you need.

 • Generating Reports, page 9-2—This section details how to generate, view, and print Cisco Unity 
reports.

See the following sections in this chapter for information on specific reports:

Subscriber Reports

 • Subscribers Report, page 9-4—This report includes profile and account information about each 
subscriber.

 • Subscriber Message Activity Report, page 9-5—This report shows when subscriber messages were 
left and when they were accessed.

 • Distribution Lists Report, page 9-5—This report shows the owner, members, and creation date of 
public distribution lists.

 • Failed Login Report, page 9-6—This report shows details of failed attempts to log on to subscriber 
accounts (by phone) and to the Cisco Unity Administrator.

 • Transfer Billing Report, page 9-7—This report provides information about call transfers from call 
handlers and subscribers; this information can be used for billing purposes.

 • Outcall Billing Report, page 9-8—This report provides information about outgoing calls made by 
Cisco Unity for message notifications; this information can be used for billing purposes.

System Reports

 • Administrative Access Activity Report, page 9-9—This report shows details of all changes entered 
into the Cisco Unity Administrator; this information can be used as an audit trail of commands 
entered by system administrators.

 • Event Log Report, page 9-10—This report provides information from the Windows application log.
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 • Port Usage Report, page 9-10—This report shows activity on each port; this information can be used 
to determine when to add new ports.

 • System Configuration Report, page 9-11—This report provides information on system resource 
allocation.

 • Unresolved References Report, page 9-12—This report shows any call handlers that were left in an 
invalid state when the Cisco Unity Administrator was not used to delete subscriber accounts.

 • Call Handler Traffic Report, page 9-12—This report shows how many calls are routed through a 
particular call handler and how callers are choosing to exit that handler.

 • AMIS Out Traffic Report, page 9-13—This report provides information about outbound AMIS calls.

 • AMIS In Traffic Report, page 9-13—This report provides information about inbound AMIS calls.

About Report Data
The Cisco Unity reports that provide information about subscribers and system activity over a period of 
time contain log-based data. For example, the Call Handler Traffic report shows how many calls are 
routed through a particular call handler and how callers are choosing to exit that handler during the time 
period that you specify. Other Cisco Unity reports offer a “snapshot” of subscriber or system data as it 
stands at the time you run the report, and therefore they reflect the current status of a particular 
Cisco Unity entity.

Cisco Unity automatically gathers and stores data that is used in log-based reports every 30 minutes. You 
specify how long Cisco Unity stores the data in the Cleanup Interval for Logger Data Files in Days field 
on the System > Configuration > Settings page. For example, if you have set this field to three, a 
log-based report will reflect activity only for the last three days, even if you specified more than three 
days in the time range for the report.

Note The raw data within files in the Event logs is stamped with time stamps recorded in GMT (Greenwich 
mean time) rather than in the local time of the Cisco Unity server. The time stamps for the Event log files 
themselves, however, are in the local time of the Cisco Unity server. Using GMT for the time stamps of 
the raw data provides for an accurate comparison of events when Cisco Unity servers are not all in the 
same time zone. The Cisco Unity reports convert the GMT time stamps to local time.

By default, Cisco Unity deletes report files every seven days. To change how often reports are deleted, 
adjust the settings for the Cleanup Interval for Report Files in Days field on the System > 
Configuration > Settings page.

Generating Reports
When you generate a report, you can specify some or all of the following:

 • The subscribers, administrators, or distribution lists to include in the report

 • The date and time range to include

 • The sort order for the data in the report
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You also choose to save the report either as a web page or as a comma-delimited file:

The best time to generate reports is when the system is not busy: after regular business hours when 
Cisco Unity is not processing many calls, or when there are no other processes running (for example, 
before or after a full backup). Note that for large systems, reports that offer a “snapshot” of subscriber 
or system data may take a significant amount of time to run.

In the current release of Cisco Unity, reports cannot be scheduled in advance, and if you turn off 
Cisco Unity while there are reports in the report queue, the reports will be deleted.

To Generate a Report

Step 1 In the Cisco Unity Administrator, choose the appropriate report from the Reports > Subscribers or 
Reports > System page.

Step 2 From the Run This Report For options menu, choose the subject of the report. (Different reports provide 
different options, such as subscribers, distribution lists, or call handlers.) 

Step 3 Choose whether to save the report to a Web page or to a comma-delimited file.

Step 4 Enter the date and time range for the report, if applicable.

Step 5 From the Order for Sorting This Report options menu, select the data field by which the report will be 
sorted, if applicable.

Step 6 Choose other optional data to be included on the report, if applicable.

Step 7 Click the Run icon.

Viewing and Printing Reports
When a report has completed, the name of the output file is displayed on the Reports page of the Status 
Monitor. To access the report file, all Cisco Unity administrators must have full read/write access and all 
Domain Users must have read rights to the CommServer\Reports directory located on the Cisco Unity 
server (these access levels are set by default). To have read rights, an administrator or user must either 
be a member of the domain that Cisco Unity is in or be associated with a domain that is trusted by the 
domain that Cisco Unity is in.

All reports contain a report header followed by columns of data. If, for example, you generate a report 
for all subscribers, the subscriber name is included above the data associated with the subscriber.

Web page An HTML file. You use a web browser to view and to print the report. In some 
cases, a report may be too large to be viewed in a web browser.

Comma-delimited 
file

A text file (also known as a comma separated or CSV file). Each row in the report 
appears on a separate line, and values are separated by commas. Select this format 
if you want to view or print the information in another application, for example, a 
spreadsheet program.
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To View a Report

Step 1 Monitor the completion status of the report in the Reports page of the Status Monitor. When the report 
has completed, note the name of the report output file.

Step 2 Go to the CommServer\Reports directory. Locate the report output file to be viewed.

Step 3 If the report is in Web page format, the browser will start automatically and display the information. If 
the report is in comma-delimited format, you may be required to choose an application in which to 
display the information.

To Print a Report

Step 1 View the report, as described in the “To View a Report” procedure.

Step 2 On the File menu, click Print.

To View the Status of a Report

The ability to view report status is controlled by class of service.

Step 1 Go to http://<Cisco Unity server name>/status, or double-click the desktop shortcut to the Status 
Monitor.

Step 2 Click Reports.

Subscribers Report
Use the Subscribers report to get a list of Cisco Unity subscribers. You can generate the report for an 
individual subscriber or for all Cisco Unity subscribers.

The Subscribers report includes the following information:

First Name, Last Name The name of the subscriber for whom the report was generated.

Note that the distribution list selection option is not supported in this release.

Alias The subscriber short name.

Location The Cisco Unity location.

Domain The Windows domain name assigned to a subscriber. This field contains no data 
when the report is run on a Domino mailstore.

Billing ID The billing ID of a subscriber.

Class of Service (COS) The class of service assigned to a subscriber.

Extension The primary phone extension assigned to a subscriber.

Alternate extensions are not listed.
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Subscriber Message Activity Report
Use the Subscriber Message Activity report to diagnose voice message problems reported by a 
subscriber (for example, voice messages are not being sent or received, or the message waiting indicator 
is not being turned on or off properly). You generate this report for an individual subscriber only.

The Subscriber Message Activity report includes the following information:

Distribution Lists Report
Use the Distribution Lists report to get a listing of all public distribution lists and, optionally, the 
members in each list. You can generate the report for a selected public distribution list or for all public 
distribution lists.

Inbox Size The total size, in kilobytes, of all e-mail, voice, and fax messages stored for the 
subscriber.

Date and Time The date and time that the subscriber took action on the message.

Source Either the computer or the phone that generated the message activity.

Action Taken in 
Response to 
Message

The activity that took place in regards to voice messages (for example, New 
Message, Message Read, Save, Delete, Mark New, Login, and Logoff).

The actions MWI On Requested and MWI On Completed indicate, respectively, 
that Cisco Unity sent a request to the phone system to turn on the MWI and received 
a request-completed confirmation. In cases where the phone system does not 
provide a confirmation, Cisco Unity assumes the request was successful.

Number of New 
Messages

The number of new voice messages in the subscriber mailbox.

Sender’s Name and 
DTMF

The name and extension of the message sender, if known.

Date and Time 
Message Arrived

The date and time that the message arrived in the mailbox.

Dial Out Number The number to which a message notification was sent.

Dial Out Result The result of the outgoing call for the message notification. Possible results include:

 • Busy—The dialed number was busy.

 • Connected—The called party answered the phone.

 • Failure—The call failed.

 • Port Disabled—All ports for outgoing calls were disabled.

 • Port Unavailable—No ports were available for the outgoing call.

 • RNA (Ring No Answer)—The dialed number did not answer.

 • Release—The result is unknown. This typically happens for notifications sent 
to pagers.

 • Unknown—The result is unknown.
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Failed Login Report
If you want the report to include the names of distribution list members, check the List All Members For 
Each Distribution List check box.

The Distribution Lists report includes the following information:

Failed Login Report
The Failed Login report includes information about failed phone user logons as well as failed 
Cisco Unity Administrator logons. Use the Failed Login report to identify patterns of invalid logons, 
which would indicate that an individual is trying to gain unauthorized access to Cisco Unity. The report 
also identifies accounts that have been locked because the maximum number of invalid logons has been 
exceeded.

You can generate the Failed Login report for all subscriber accounts. Additionally, you can indicate 
whether to show all failed logon attempts (expand the report) or show only the last failure for each 
subscriber.

Note that including the Failed Login report for the Cisco Unity Administrator logons requires that 
auditing be enabled in system security policies. Cisco Unity setup enables auditing by default.

The Failed Login report includes the following information about failed phone user logons:

Creation Date The date that the public distribution list was created.

List Alias The short name of the public distribution list.

Count The number of subscribers and other public distribution lists that are 
members of the public distribution list.

Distribution List Name The name of the public distribution list.

Owner First and Last Name The subscriber or public distribution list that owns the public distribution 
list.

If the List All Members check box is checked, this column also includes the 
names of subscribers and other public distribution lists that are members of 
the public distribution list.

Member List This column is not used.

Subscriber/User 
Name

The display name of the subscriber whose account experienced the failed logon.

Note that the select option to choose a subscriber is not supported for this release. 

Alias The short name of the subscriber whose account experienced the failed logon.

Caller ID (Phone 
Number Called 
From)

The calling number, if known, from which the logon was attempted.

Subscriber DTMF The unique DTMF access code that callers dial to access this account.

Date and Time The date and time of the failed logon.

Maximum Failures 
Exceeded

Whether the failed logon exceeded the maximum number allowed; if so, the account 
is locked.

Failure Number A running total of failed logons by subscriber or by day, depending on how the 
report is sorted.
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The Failed Login report also includes the following information about failed Cisco Unity Administrator 
logons:

Transfer Billing Report
Use the Transfer Billing report to obtain information about calls that are transferred from a subscriber 
account or from a call handler. You can use this report for billing purposes or to keep track of transfers 
to long distance phone numbers. You can generate the report for all subscribers, or all billing IDs, or for 
a single distribution list or single call handler. Note that the single subscriber, single billing ID, 
distribution lists, and all call handler selection options are not supported in this release.

Only those subscribers with call transfer data appear on the report.

The Transfer Billing report includes the following information:

Source Indicates either Standard when a subscriber uses normal Cisco Unity password 
security, or Enhanced when a subscriber uses enhanced phone security to log on.

User Name The logon name assigned to the subscriber.

Computer The name of the workstation, if known, from which a subscriber attempted to log on.

User Domain The Windows domain name assigned to a subscriber.

Event ID The Windows event ID that was generated when the logon failed.

Date and Time The date and time of the failed logon.

Failure Number A running total of failed logons by subscriber or by day, depending on how the report 
is sorted.

Name The name of the Cisco Unity entity (such as subscriber, call handler, or interview 
handler) from which the call was transferred.

Extension The extension of the Cisco Unity entity (such as subscriber, call handler, or interview 
handler) from which the call was transferred.

Billing ID The billing ID of the Cisco Unity subscriber from which the call was transferred.

If the Cisco Unity billing ID for a subscriber is blank (the Billing ID field on the 
Subscribers > Account screen), then 0 (zero) is listed as the value for this field on the 
report.

Note that other entities from which calls are transferred, such as call handlers, 
directory handlers, and interview handlers, do not have billing IDs.

Date The date that the transfer occurred.

Time The time that the transfer occurred.

Dialed Number The number that the call was transferred to.
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Outcall Billing Report
Use the Outcall Billing report to obtain information about outbound calls made by Cisco Unity for 
message notifications. This report also provides information about outbound calls that Cisco Unity 
makes to subscriber extensions when subscribers use their phones as the recording and playback device 
for the Media Master. You can use this report for billing purposes, or to keep track of message 
notifications sent to long distance phone numbers. You can generate the report for subscribers, billing 
IDs, or for a distribution list.

Note that the Dial Time option is not supported in this release.

The Outcall Billing report includes the following information.

Transfer Result The result of the call. Possible results include:

 • Connected—The called party answered the phone.

 • Busy—The dialed number was busy.

 • RNA (Ring No Answer)—The dialed number did not answer.

 • Released—The result is unknown.

Name The name of the Cisco Unity entity (such as subscriber, call handler, or interview 
handler) that made the call.

Extension The extension of the Cisco Unity entity (such as subscriber, call handler, or 
interview handler) that made the call.

Billing ID The billing ID of the Cisco Unity subscriber from which the call was transferred.

If the Cisco Unity billing ID for a subscriber is blank (the Billing ID field on the 
Subscribers > Account screen), 0 (zero) is listed as the value for this field on the 
report.

Note that other entities from which calls are transferred, such as call handlers, 
directory handlers, and interview handlers, do not have billing IDs.

Time The time that Cisco Unity made the call.

Delivery Device The notification device that the message was sent to, which can be a home phone, 
work phone, spare phone, or pager. When the phone is used as the recording and 
playback device for the Media Master, the word “TRAP” (Telephone Record And 
Playback) is listed as the delivery device. 

Dialed Number The phone number of the delivery device.
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Administrative Access Activity Report
Use the Administrative Access Activity report to track which system administrators changed values in 
Cisco Unity during a specified period and the changes they made. You can generate this report for all 
administrators. The option to select a single administrator is not supported in this release.

The Administrative Access Activity report includes the following information:

Result The result of the call. Possible results include:

 • Busy—The dialed number was busy.

 • Connected—The called party answered the phone.

 • Failure—The call failed.

 • Port Disabled—All ports for outgoing calls have been disabled.

 • Port Unavailable—No ports were available for the outgoing call.

 • RNA (Ring No Answer)—The dialed number did not answer.

 • Release—The result is unknown. This typically happens for notifications 
sent to pagers.

 • Unknown—The result is unknown.

Call Time (Seconds) The length of the call, in seconds.

Date and Time The date and time that the administrator created, deleted, or updated data for a 
Cisco Unity entity (such as subscriber, call handler, or interview handler).

 Administrator’s 
Short Name

The administrator short name.

Administrator’s 
First and Last 
Name

The name of the administrator.

DTMF ID The extension assigned to the administrator.

Administrative 
Action

Whether the administrator action created, updated, or deleted data for a Cisco Unity 
entity.

Object The type of Cisco Unity entity (such as subscriber, call handler, or interview handler) 
that the administrator created, deleted, or updated.

Name The name of the Cisco Unity entity (such as subscriber, call handler, or interview 
handler) that the administrator created, deleted, or updated.

Field (Property) The name of the field from the page in the Cisco Unity Administrator that was 
changed in creating, updating, or deleting data for a Cisco Unity entity.

Value The new value for the changed field.
9-9
Cisco Unity 4.0(5) Maintenance Guide (With IBM Lotus Domino)

OL-7400-01



  

Chapter 9      Reports
Event Log Report
Event Log Report
Use the Event Log report to list events from the Windows application log. You can generate the report 
for all application events on the Cisco Unity server, or for the events that apply only to Cisco Unity. Note 
that Cisco Unity writes events only to the Windows application log; it does not write events to the system 
or security logs. If you generate a report for all application events, you can identify the Cisco Unity 
events as those events that begin with “CiscoUnity” or “AV” (for example, “CiscoUnity_LogMgr”).

You can also view application events by using the Windows Event Viewer (on the Windows Start menu, 
click Programs > Administrative Tools > Event Viewer). For more information on Windows events, refer 
to the Windows Event Viewer Help.

The Event Log report includes the following information:

Port Usage Report
You can use the Port Usage report to determine if the voice messaging system is running close to 
capacity, and indicate a specific port or ports to include in the report. Enter port numbers or ranges of 
numbers separated by commas (for example, 1,2,4-8) in the Ports to Show field. Note that this report 
fails if the specific port numbers or ranges that are entered are not valid (for example, do not enter a port 
range of 10–50 if there are only 48 ports on the system.)

As an alternative to the Port Usage report, we recommend using the Port Usage Analyzer, available in 
Tools Depot. For more information, refer to the Port Usage Analyzer Help.

The Port Usage report includes the following information:

Date and Time The date and time that the event occurred.

Type The Windows event type.

Source The component that caused and logged the event.

Message (Msg) ID The event ID.

Computer The server on which the event occurred.

More Info A message that contains additional information about the event.

Port Number The Cisco Unity port number.

Unit of Time The unit of time by which data is broken down for the time period that you 
specified in the Date Range. Depending on the length of the time period, data 
is broken down into hours, days, and weeks.

Date Range The range of dates for which data is included.

Time The specific hour or date(s) by which data is broken down for the time period 
that you specified in the Date Range.

Ports The ports included in the report.

Number of Calls The number of calls processed by the port per hour, day, or week for the time 
period specified.

Length of Calls The total length, in milliseconds, of all calls on the port per hour, day, or week 
for the time period specified.
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System Configuration Report
Use the System Configuration report to get information about the Cisco Unity server and software. You 
also can view this information in the Cisco Unity Administrator on the Configuration pages.

The System Configuration report includes the following information:

Average Length of Calls The average length, in seconds, of all calls on the port per hour, day, or week 
for the time period specified.

Percent Utilization The percentage of available time that a port was in use per hour, day, or week.

Note that we recommend that the value of Percent Utilization not exceed 80 
percent of the ports used for incoming calls during peak usage.

Average Calls Per Hour The average number of calls per hour for each port.

Average Calls Per Day The average number of calls per day for each port. This information is provided 
only on the row that contains the summary for the week.

Serial Number This field is not applicable to the current version of the report. 

OEM Code This field is not applicable to the current version of the report. 

Product The name of the software product and version number.

Number of Voice Ports The number of voice ports licensed for the Cisco Unity system.

Languages The number of language licenses.

Available Licenses and 
Total Licenses

The available and total number of Cisco Unity licensed features, such as 
Digital Networking. Note that the presence or absence of the AMIS feature 
is not listed on this report.

Leading Silence for 
Recordings

The length of silence, in seconds, allowed at the beginning of a recording. 
When the leading silence is longer than specified, Cisco Unity stops 
recording and discards the recording.

Trailing Silence for Short 
and Long Recordings

The length of silence, in seconds, allowed at the end of recordings that are 30 
seconds or less and of recordings that are more than 30 seconds. When the 
trailing-silence limit is reached, Cisco Unity assumes the recording is 
finished and stops recording.

Minimum Length for a 
Recording

The minimum length of a recording, in seconds. When a recording is shorter 
than the minimum length, it is discarded.

Computer and Windows 
Domain Name

The Cisco Unity server name on the network and the Windows domain name.

Total Hard Drive Space, 
Total Used Hard Drive 
Space, and Total Free 
Space

The total size of all hard disks, the total amount of space in use, and the total 
free space on the Cisco Unity server.

Additional Settings The report contains additional information about the Cisco Unity server and 
software, such as integration type, Cisco Unity Assistant licensing, and the 
Text to Speech engine.

(Note that in version 3.1 and earlier, the Cisco Unity Assistant was known as 
the ActiveAssistant, or AA.)
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Unresolved References Report
Use the Unresolved References report to locate primary call handlers (those call handlers that are 
associated with a subscriber account), other call handlers, and interview handlers that are left unresolved 
because of the improper deletion of a subscriber account. The problem occurs when a subscriber is 
deleted by using Lotus Domino or Windows administrator applications without first deleting the 
subscriber by using the Cisco Unity Administrator.

If the report finds a problem with a call handler, directory handler, or interview handler, run the 
Cisco Unity Directory Walker (DbWalker) utility, available in Tools Depot, to repair the problem.

The Unresolved References report includes the following information:

Call Handler Traffic Report
Use the Call Handler Traffic report to track the number of calls routed by call handlers, and how callers 
chose to exit the handlers.

This report can only be run for all call handlers. Note that the option to select a single call handler is not 
supported in this release.

There are four ways a caller can exit a call handler: by hanging up, by choosing a one-key dialing option, 
by dialing an extension that transfers the call to another call handler (or subscriber), or by being routed 
automatically by the after-greeting action specified in the call handler.

The Call Handler Traffic report includes the following information:

Handler Name The name of the unresolved handler.

Handler/Access ID The extension (if any) associated with the handler.

Handler Type The type of handler found to be in an unresolved state. The type can include call 
handlers, interview handlers, the directory handler, or primary call handlers.

Owner The owner of the handler.

Message Recipient The message recipient associated with the handler.

Start Time The specific hour or date(s) by which data is broken down for the time period that 
you specified in the Date Range.

Total Calls The total number of calls routed to the call handler.

Method Callers Use to 
Exit a Call Handler

The total number of times each exit method is used by callers. Callers can exit a 
call handler by hanging up, pressing a one-key dialing option, dialing an 
extension that transfers the call to another call handler (or subscriber), or by 
being routed to another call handler (such as the Goodbye call handler) as 
specified by the after-greeting action.

Key The number of calls in which the caller exited the call handler by pressing a 
one-key dialing option. The report includes a tally for each key.

DTMF ID The number of calls in which the caller exited the call handler by dialing a valid 
extension to transfer to another call handler (or subscriber).

Invalid DTMF ID The number of calls routed to the default Error call handler because the caller 
dialed an invalid extension.
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AMIS Out Traffic Report
Use the AMIS Out Traffic report to track the progress of outbound AMIS messages. This report is 
available only if your organization purchased the AMIS feature.

The Outbound AMIS Traffic report includes the following information:

AMIS In Traffic Report
Use the AMIS In Traffic report to track the progress of inbound AMIS messages. This report is available 
only if your organization purchased the AMIS feature.

The AMIS In Traffic report includes the following information:

After Greeting Action The number of calls routed according to the after greeting action specified for the 
call handler.

Hang-Up The number of calls in which the caller exited the call handler by hanging up.

Submit Date and Time The date and time that the AMIS message transmission was completed. 
Note that the time may differ from actual delivery time because AMIS 
messages are transmitted in batches at scheduled times.

Importance (Urgency) Indicates whether the subscriber marked the AMIS message “Urgent” 
before sending it to the destination node.

Sender’s Primary 
Extension/Sender

The extension of the subscriber who sent the AMIS message to the 
destination node.

Target Device/Target 
Mailbox Delivery Number

The remote mailbox ID number of the AMIS message recipient.

Transmission Start Time The date and time that Cisco Unity started the transmission of the AMIS 
message to the destination node.

Transmission Duration The total number of seconds needed to transmit the AMIS message from 
one node to the other.

Delivery Status “Sent OK” is specified for successful deliveries. Note that failed deliveries 
are not displayed on this report.

Total Transmission Time The total transmission time for all AMIS messages sent, specified in 
seconds.

Total Messages Delivered 
Successfully

The total number of AMIS messages that were delivered within their 
specified delivery schedules.

Total Failed Messages This data is not available in this release.

Start 
Reception/Transmission 
Receive Time

The date and time that Cisco Unity began receiving the transmission of the 
AMIS message.
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Matching ID/Remote Sender 
ID

The remote mailbox ID number of the remote subscriber sending the AMIS 
message. If Cisco Unity cannot find a matching ID for the node that sent a 
message, this section in the report is left blank, and the delivery is reported 
as a failure in the Status column.

Target User’s Primary 
Extension/Recipient 
Extension

The extension of the subscriber for whom the AMIS message is intended. 
If Cisco Unity cannot find the subscriber extension in the directory, this 
section in the report is left blank, and the delivery is reported as a failure in 
the Status column.

Transmission Duration The total number of seconds needed to transmit the AMIS message from 
one node to another.

Delivery Status “Received OK” is specified for successful deliveries. Note that failed 
deliveries are not displayed on this report.

Port Number The number of the port that received the AMIS message.

Total Transmission Time The total transmission time for all AMIS messages that were received, 
specified in seconds.

Total Messages Received 
Successfully

The total number of AMIS messages that were received within their 
specified delivery schedules.

Total Failed Messages This data is not available in this release.
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